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Morpheus V4.6 Introduction
1. Introduction

Welcome to Morpheus, Grass Valley’s flagship TV transmission automation product. 
Morpheus is a powerful, highly sophisticated, stable, fully scalable, feature-rich system 
offering facilities that satisfy the most demanding transmission requirement.

The main component of the Morpheus automation system for operators is the Editor 
application. The Editor provides the means of working with ‘events’ on the ‘schedule’ (refer to 
page 5). Figure 1 below shows the main parts of the Editor window.

Important: On Windows 7 platform, ensure that the display setting in Control Panel > Appearance and 
Personalization > Display is set to ‘Smaller - 100%’, otherwise some Morpheus windows 
will not be displayed correctly.

ToolbarChannel Bar

Schedule

Clock

Property InspectorEvent RulerStatus Bar

Event CountdownEvent

Figure 1   Morpheus Editor Main Display
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1.1 Components of the Editor Window

There are nine main components of the Editor window:

• Channel bar (refer to page 5)

• Events (refer to page 6)

• Schedule (refer to page 5)

• Toolbar (refer to page 7)

• Event countdown (refer to page 13)

• Clock - shows the current system time

• Status bar (refer to page 9)

• Event ruler (refer to page 122)

• Property Inspector (refer to page 166)

1.2 Online Editor/Offline Editor

The Editor can run in one of two modes: online and offline. Each is described briefly below.

Online Editor

The Online Editor accesses the on-air schedule and shows the system time (clock) in the top 
right-hand corner.

Offline Editor

The Offline Editor does not access the on-air schedule. It allows schedules to be created and 
edited offline. The Offline Editor is used for the following tasks:

• Build schedules for the future without affecting the online schedule.

• Check the timing and flow of sequences before including the events in the on-air 
schedule.

• Check the status of material in the Morpheus media management database (refer to 
page 212). 

• Create schedules that can be saved and appended to the online schedule at a later 
time.

The Offline Editor differs from the Online Editor in the following ways:

• It does not include the event countdown (refer to page 13).

• The word ‘Offline’ is displayed in place of the clock.

• An ‘Offline’ menu is displayed on the menu bar. 
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1.2.1 Roles - Restricting Access to the Online/Offline Editors

When logging on to the Editor, it is necessary to use a ‘role’. The selected role sets 
permissions and restrictions for options that are relevant to the operator. Any channels and/or 
options that are not enabled for a role are greyed out.

Once logged in using one particular role, it is possible to switch to another role without exiting 
from the Editor.

1. From the Menu Bar select File > Change Role.

The Role Login dialog box is displayed.

2. From the Role name list, select the required role.

3. When prompted, enter the password associated to the role and click OK.

1.2.1.1 Starting the Online Editor

Start the online Editor using either the desktop shortcut or the shortcuts folder as described 
below.

• A shortcut for the Online Editor may have been created on the desktop. If so, dou-
ble-click on the shortcut.

• If a shortcut has not been created, start the Online Editor using the Morpheus Short-
cuts Folder.

1. On the desktop, open the Morpheus Shortcuts folder.

2. Double-click Editor.

The Role Login dialog box is displayed.

3. Select the Role name (the system may be configured to select the role automatically).

4. Enter a Password, if applicable, and then click OK.

Note: Some of the options documented in this manual may not be enabled on all user roles.
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1.2.1.2 Starting the Offline Editor

The Offline Editor is started using either the desktop shortcut or the shortcuts folder as 
described below. 

• A shortcut for the Offline Editor may have been created on the desktop. If so, dou-
ble-click on the shortcut.

• If a shortcut has not been created, start the Offline Editor using the Morpheus Short-
cuts Folder.

1. On the desktop, open the Morpheus Shortcuts folder.

2. Double-click Offline Editor.

Depending on the system configuration, the Role Login dialog box may appear.

3. Select a Role name, if applicable (the system may be configured to select the role 
automatically).

4. Enter a Password, if applicable, and then click OK.
Issue 1 Rev. 2 Page 4



Morpheus V4.6 Introduction
1.3 Channel Bar

The ‘channel bar’ is displayed in the left-hand pane of the Editor window. It displays all of the 
channels that have been made visible for the current role, and in their preconfigured order 
(vertically, starting at the top). After switching roles (refer to Section 1.2.1 Roles - Restricting 
Access to the Online/Offline Editors), the channel that was on display for the previous role 
remains displayed for the new role as long as that channel is configured as ‘visible’ for both 
roles; if the channel is not configured as ‘visible’ for both roles, then the display will default to 
the first channel (as defined by the preconfigured Channel Order).

To display the schedule for a channel, click the channel icon on the channel bar.

If the displayed schedule is intended for a different channel, a warning symbol  appears 
alongside the channel icon.

It is possible to jump to the first channel by pressing on the left curly bracket key ‘{‘, or to the 
last channel by pressing the right curly bracket key ‘}’.

1.4 Schedule

The ‘schedule’ shows a list of events (refer to page 6) to be played out at specific times.

A typical schedule contains recordings, graphics, live material and other items, that make up 
the channel input seen by the viewer.

Each automation channel has its own schedule.

The Editor communicates with the Morpheus media management database that runs in the 
background and stores information (such as the duration or title) for each piece of server and 
tape-based material. The Editor takes information from the database and uses it to populate 
the relevant fields on the schedule. Operators can edit these fields, if required (refer to 
page 26).

Figure 2   Channel Bar
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1.5 Events

An ‘event’ instructs one or more broadcast devices to perform an action at a specific time.

Each event appears as a row on the schedule.

The event that is playing out is called the ‘on-air event’. It is also known as the ‘current event’ 
or ‘programme (PGM) event’. It appears above the red line at the top of the schedule.

The event scheduled to play immediately after the on-air event is called the ‘preset event’.

When an event has played, it is greyed out for one minute (this duration depends on the 
system configuration) and is removed from the schedule. It may then be placed in the ‘as run 
log’ (refer to page 93).

Figure 3    On-Air, Preset and Past Events
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1.6 Toolbar

The ‘toolbar’ is displayed at the top of the Editor window, below the menu bar.

All of the toolbar buttons are shown in the table below.

Note: If a toolbar button is not enabled for a role, it is greyed out.

Button Description

Load Schedule. Refer to ‘Loading a Schedule’ on page 54.

Append Schedule. Refer to ‘Appending a Schedule’ on page 55.

Save Schedule. Refer to ‘Updating a Schedule’ on page 53.

Save As Schedule. Refer to ‘Saving a Schedule for the First Time’ on page 53.

Clear. Refer to ‘Clearing the Schedule’ on page 47.

Cut. Refer to ‘Changing the Order of Events’ on page 45.

Copy. Refer to ‘Changing the Order of Events’ on page 45.

Paste. Refer to ‘Changing the Order of Events’ on page 45.

Paste Top. Refer to ‘Moving/Copying Events after the On-Air Event’ on page 46.

Search and Replace. Refer to ‘Basic Search and Replace’ on page 15.

Palette. Refer to ‘The Palette’ on page 131.

Configuration. Refer to the Morpheus Engineer’s manual for further information.

Show MIP. Refer to ‘Manual Intervention Panel’ on page 97.

Table 1   Editor Toolbar Buttons
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Show Channel Flow Control. Refer to Chapter 4.14.4 Using the CFC Interface.

Ripple. Refer to ‘Rippling a Schedule’ on page 52.

Go To Top. Refer to ‘Moving Around the Schedule’ on page 43.

Go To Bottom. Refer to ‘Moving Around the Schedule’ on page 43.

Expand All. Refer to ‘Displaying/Hiding Secondary Events’ on page 108.

Collapse All. Refer to ‘Displaying/Hiding Secondary Events’ on page 108.

Expand All Break Headers. Refer to ‘Displaying/Hiding Break Headers’ on 
page 112.

Collapse All Break Headers. Refer to ‘Displaying/Hiding Break Headers’ on 
page 112.

Track Program Event. Refer to ‘Track Program Event’ on page 50.

Add a Default Event. Refer to ‘Adding a Default Event to the Schedule’ on 
page 139.

Button Description

Table 1   Editor Toolbar Buttons
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1.7 Status Bar

The status bar is displayed at the bottom of the Editor window providing information on the 
schedule for the currently selected channel. An example is shown below.

1.7.1 Rolling Hour

If the ‘rolling hour’ option is enabled in the Editor configuration, it performs a dynamic check 
on one of the following:

• Programmes (main programme items)

• Commercials (revenue generating advertisements)

• Junction events (channel idents and other interstitials)

• Live events (live studio items)

• Other events that are marked individually on the Property Inspector.

The rolling hour is displayed on the status bar as a percentage or duration of either:

• A 60 minute period (which could be partly in the future), or

• The current or previous complete clock hour.

The on-air event is on 
hold. Refer to ‘Hold’ on 
page 104.

The name of the 
schedule.

The number of 
events on the 
schedule: on 
air/awaiting playout 
and - played events 
(in brackets.

The percentage or duration of a 
programme type in the selected 
or rolling hour (refer to ‘Rolling 
Hour’ below).

Figure 4   Status Bar Messages
Issue 1 Rev. 2 Page 9



Morpheus V4.6 Introduction
1.7.2 Alarms

If an alarm exists, the alarms icon is displayed on the left-hand side of the status bar:

Double-click the icon in order to display the alarms table.

Figure 5    Alarms Table

Note: Alarms can also be displayed by selecting Alarms from the Tools menu.
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1.8 Panoplay

The purpose of Panoplay is to synchronize schedules between channels that access different 
Event Stores. For example, using Panoplay, a Follower schedule can be modified so that it is 
identical to a Leader channel schedule - any change to a Leader channel is applied 
immediately to the Follower channel. A change made in a Follower channel is overwritten 
immediately by the Leader channel.

During the synchronization process, automation is switched off on the Follower system, and 
no automation commands are issued during this period. This state is indicated in the Editor.

A Follower channel cannot be the on-air channel - if Panoplay detects that a Follower channel 
is on-air, it will be un-synchronized from the Leader channel in order to prevent playout 
problems.

1.8.1 Multisystem Synchronisation

Panoplay supports synchronization with a third (or more) EventStore for disaster recovery and 
upgrade purposes. Each additional EventStore requires its own Panoplay Agent. These 
additional systems (mirrors) cannot become the Panoplay Leader.

Figure 6   Panoplay Multisystem Synchronisation
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1.9 Panoplay Status

The Panoplay status is displayed the Editor window as either Leader, Follower or 
Unsynchronized. It is shown in the title bar of the window and in a panel to the bottom-left as 
shown below:

If configured, the Follower system will be indicated by a large banner displaying its name 
across the Editor grid.

Panoplay alarm messages appear on the bottom toolbar and can be acknowledged using the 
Editor Alarms functionality.

Note: The Leader / Follower names are the defaults and may have been changed in the system 
configuration.

Figure 7    Panoplay Panel on the Editor
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1.10 Event Countdown

The ‘event countdown’ counts down in hours, minutes and seconds to either the next live 
event or to a highlighted event in the schedule.

1.10.1 Count Down to the Next Live Event

1. Right-click on the clock digits in the event countdown to display the following menu.

2. Select Track Live Event.

1.10.2 Count Down to a Selected Event

1. Right-click on the clock digits in the event countdown and select Track Selected 
Event.

2. Highlight the required event on the schedule.

3. Right-click on the event and select Track selected event.

1.11 Resizing Areas of the Editor Window

The width of different areas of the Editor window can be changed, such as the 
Property Inspector or the channel bar.

1. Point to the left or right border of the area to change.

The mouse pointer is displayed as follows: 

2. Click and drag the area to the required width.

Note: The Event Material Type field (refer to page 190) in the Property Inspector (refer to 
page 166) must be set to Live.

Figure 8    Event Countdown
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1.12 Changing the Editor skin

The look and feel of the Editor window can be changed by selecting a skin type from the 
toolbar menu. Click on Skin, and then one of the following options (the skin change is applied 
instantly):

• Classic - selects the standard color scheme as shown below:

• Light - selects a light grey color scheme as shown below:

• Dark - selects a dark grey color scheme as shown below:

Figure 9    Classic Skin

Figure 10    Light Skin

Figure 11    Dark Skin
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2. Search and Replace

This section contains information on searching for material and replacing it in the Editor.

2.1 Basic Search and Replace

The Search and Replace option allows material to be searched for based on its ID, title or 
source and, if required, replace these for one or more events.

To search for material:

1. From the Edit menu, choose Search And Replace or on the toolbar, click Search 
and Replace as shown below:

The Search and Replace dialog box is displayed.

2. In the Search For area, select Material Id, Title or Source.

3. In order to search for more than one channel, select Search Multiple Channels. 
Select the check boxes for all channels to be included.

4. In the Material Id field, type the ID of the material to be searched for

or

5. In the Title field, type the title of the material to be searched for

or

6. From the Source list, select the source of the material to be searched for.

7. In the Replace With field, enter the material ID or title, or select the source from the 
list.

Figure 12    Search and Replace Dialog Box
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2.1.1 Searching for Events

Click Search Next to search for the next event that matches the search criteria. 

Click Search Prev to search for the previous event that matches the search criteria

Click Search All to highlight all events that match the search criteria.

2.1.2 Replacing Events

To replace a single event:

1. Click Search Next and either:

• To replace the event, click Replace.

• To leave the event as it is, click Search Next.

2. Continue in this way until all required events are replaced.

To replace all events, click Replace All.

2.1.3 Finding the Next Highlighted Event

If Search All is pressed in the Search and Replace dialog box, Morpheus highlights all events 
that match the search criteria. Search for the next highlighted event as follows:

• From the Edit menu, select Find Next Highlighted Event or

• Press F3.

2.1.4 Clearing All Highlighted Events

From the Edit menu, select Clear Highlights.

Note: To close the Search and Replace dialog box, click Close.
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2.2 Advanced Search and Replace

Advanced Search and Replace provides the following functions:

• Search for all events that meet one or more conditions (refer to ‘Selecting Search Cri-
teria’ below).

• Save search results for future use (refer to ‘Saved Searches’ on page 24).

• Replace event fields on the schedule with a different value (refer to ‘Replacing Event 
Fields’ on page 23).

On the Editor menu bar click on Edit and select Advanced Search And Replace (Figure 13). 

Figure 13   Open the Advanced Search Window from the Editor Menu Bar
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The ‘Advanced Search’ window is displayed (Figure 14).

Figure 14    Advanced Search Window
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2.2.1 Selecting the Search Criteria

1. In the ‘Channels to Search’ pane, select each channel that the search is to apply to by 
using the checkboxes. In order to apply a search to all configured channels, tick the 
Select All Channels check box.

2. In the ‘Build a Search’ pane, select the parameter type on which to base the search:

• Actual Start Time

• Event Kind

• Field

• Start Type

Depending upon the selected parameter type, different property menus are displayed 
containing appropriate qualifiers to refine the search (Figure 15).

•

3. Select the required qualifiers from the drop-down menus and alphanumeric fields.

Figure 15    Advanced Search - Build a Search

Filter Parameters Qualifiers
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4. Click on the And button to create a compound filter by applying one or more addi-
tional parameters to a single search - any results will have to match all of the config-
ured criteria.

Example

The following compound filters would find all material events with a start date of 
30June 2014.

5. Click on the Search button.

All events that contain matches to the search criteria are displayed under the ‘Search 
Results’ section.

Note: A greyed-out event in the ‘Search Results’ pane is one that has already played.
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2.2.2 Function Buttons

- And

Create a compound filter by applying one or more additional parameters to a single 
search.

- Clear All

Reset the search parameters to their default setting.

- Show All (Field based searches only)

By default for Field based searches, the event type property must be configured as 
‘Visible’ in the Configurator in order to appear in the field selection drop-down menu.

Tick the Show All check box in order to override the ‘Visible’ flag if it is disabled (the 
property is set to not visible). Refer to Editor section of the Morpheus Engineer’s Manual 
for further information on parameter visibility.

- Use UTC

Display the Start Time of the search results as UTC - the default is local time.

- Export to CSV

Save all selected search results to a CSV file - Windows Explorer is displayed to allow the 
selection of a filename and destination folder.

- Clear

Clear the search results pane.

- Search

Run the search criteria on the selected channels.

- Refresh

Refresh the search window, updating the current search results.

- Delete

Delete a search. In the ‘Saved Searches’ pane, select the search item to delete and click 
on Delete - a confirmation window is displayed

Note: To clear a single filter, click on the minus button  alongside it.
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- Save Search

Save a configured ‘Search’ filter combination for future use. Windows Explorer is opened 
to allow the selection of an appropriate file name - by default, searches are saved in the 
following folder: C:\Morpheus\SavedSearches

- Save S&R

Save a configured ‘Search and Replace’ filter combination for future use. Windows 
Explorer is opened to allow the selection of an appropriate file name - by default, searches 
are saved in the following folder: C:\Morpheus\SavedSearches
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2.2.3 Search Examples

The following criteria finds all events created on or after 12 January 2012 with a start time of 
14:37:10:00 or later:

The following criteria finds all break header events (refer to page 112):

The following criteria finds all events set to Manual Take:

The following criteria finds all events that have a fixed start type:

To find events that have a follow-on start type, deselect the IsFixed option.

To find only top level events, select the IsTopLevel option. Otherwise, the search returns all 
matching events regardless of level.

2.2.4 Search and Replace Function

This facility (search and replace) acts upon all event property fields that exist in the system. 
When altering property fields - the change is only performed on the instance of the event that 
exists within the schedule, and only for events that are either currently playing, or are yet to 
play - the change has no effect upon events that have finished playing, nor does it affect the 
parameter values in the EventStore.

To replace the search fields:

1. Select the events for which fields are to be altered: either double click on the event or 
single click on event’s checkbox.

2. From the Field to Alter list, select the required field and click on OK.

3. In the New Value box, enter the new value and click on Apply.

Note: To edit all events, select Select all Events.
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2.2.5 Saving a Search

Save a search for future use, as follows:

1. Create a search using the criteria in the Build a search section.

2. Under Saved Searches, click Save Search.

The Save As dialog box is displayed.

3. Browse to the required drive and folder.

4. In the File name box, type a name for the search and click Save.

The search item is displayed under Saved Searches.

2.2.6 Saving a Search and Replace 

Save the results of a search and the altered field values to be applied:

1. Under Saved Searches, click Save S&R.

The Save As dialog box is displayed.

2. Browse to the required drive and folder.

3. In the File name box, type a name for the search and click Save.

The search conditions appear under Saved Searches.

2.2.7 Using a Saved Search

To use a saved search:

1. From the Saved Searches list, select the required search.

The Build a Search fields change to reflect the new search conditions.

2. Click Search. The matching events appear in the Search Results area.
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3. Schedule Columns

The columns on the schedule provide information about each event, for example:

• The clip that is required

• The time at which the clip should be played out

• The duration of the clip

• The device that the clip will play out from

3.1 Manipulating Columns

Changing the Width of a Column

To change the width of a column:

1. Point to the right edge of the relevant column heading.

2. Drag the column heading until the column is the required width.

Changing the Order of Columns

To change the order of a column:

1. Point to the heading of the column to move.

2. Click and drag it to the required position.
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3.2 Event Fields

Each column has a heading, or ‘field’, such as Duration, Title or Start Time. It is also possible 
to create custom columns.

The fields and information displayed depend upon the configuration of the Editor.

Event Fields

Figure 16   Event Fields
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3.2.1 Event Field: Start Time

The Start Time field shows the time the event is due to start. It is displayed in hh:mm:ss:ff 
(hours, minutes, seconds, frames).

Appearance

Blue text indicates that the event is a follow-on event (refer to page 121).

Red text indicates that the event is a fixed event (refer to page 122).

Underlined text indicates that the event is set for ‘Manual Take’ (refer to page 190) and 
requires operator intervention.

Dual Start Times

If two start times are shown, the first line shows the time the event was set to start and the 
second line shows the earliest time it can start. Such an event will not play without manual 
intervention (refer to ‘Hold’ on page 104).

Icons

The following icons appear if operator intervention is required:

Note: Change the start time of a fixed event using the Start Type field (refer to page 174) on the 
Property Inspector (refer to page 166).

Note: The color and appearance of the Start Time text depend on the configuration of the Editor.

Note: The start date may also appear in the Start Time field.

Note: Second line information may have been suppressed in the configuration.

Icon Description

Indicates that the event is on hold (refer to ‘Hold’ on page 104).

Indicates that the event is set for Manual Take (refer to ‘Manual Take’ on 
page 190).

Table 2   Start Time Icons
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3.2.2 Event Field: Link

This column relates to primary and secondary events (refer to page 108).

The Link column shows a continuous vertical dotted line for primary events, indicating that 
each event follows on from the previous.

If a primary event has secondary events below it, a plus symbol is displayed in the Link field.

• To display the secondary events, click on the plus sign. A minus sign is displayed in its 
place.

• To hide the secondary events and display the primary event only, click on the minus 
sign.

3.2.3 Event Field: Title

The Title field shows the title of the event on the first line and the ‘material ID’ on the second 
line.

The material ID is a unique identifier for a piece of material. It is an alphanumeric string of up 
to 20 characters. It is generated by the broadcaster using an agreed ‘formula’ and may 
incorporate elements relating to the date, the channel, the production company, the client and 
so on.

To change the title and/or material ID, double-click on the title or material ID and then make 
the changes.

Note: A secondary event may have further secondary events below it. A second continuous 
vertical dotted line indicates that each secondary event follows on from the previous, as 
does a third dotted line.

Figure 17   Event Fields

Note: Second line information may have been suppressed in the configuration.

Note: The title and material ID can also be changed using the Event Name and Material Id fields 
on the Property Inspector, if the system configuration allows it (refer to ‘The 
Property Inspector’ on page 166, ‘Event Name’ on page 186 and ‘Material Id’ on 
page 183).

To reset the title/material ID to their original values, use the Query button (refer to 
page 170).
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3.2.4 Event Field: Offset

This field shows the time difference between the start of a secondary event and the start/end 
of the primary event above it (refer to ‘Primary and Secondary Events’ on page 108).

The offset is displayed in hours, minutes, seconds and frames.

This field links to the Offset field in the Property Inspector (refer to ‘The Property Inspector’ 
on page 166 and ‘Offset’ on page 172).

To view the timing relationships between primary and secondary events, use the Event Ruler 
(refer to page 122).

The Offset field links to the Start Mode field on the Property Inspector (refer to ‘Start Mode’ 
on page 173).

3.2.5 Event Field: Mix

This field displays an icon that represents the mixer transition for the start of the event. The 
default transition is ‘Cut’.

To change the mixer transition, double-click on the Mix field for the relevant event. Select the 
required transition from the list.

Note: Transitions other than cuts are only possible if the system includes a mixer.

The transition can also be changed using the ‘Transition Type’ field on the 
Property Inspector, if the system configuration allows it (refer to ‘The Property Inspector’ on 
page 166 and ‘Transition Type’ on page 176).

When two back-to-back main events are scheduled to play out on the same source, and 
they are configured for anything other than a transition of type ‘cut’, then the following will 
occur:

• The event that is that is due to transition out is truncated at the start of the 
transition, thereby producing the effect of a cut

• The event that is transitioning in will do so at the programmed time and according 
to the configured transition type
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3.2.6 Event Field: Duration

A countdown of the remaining duration of the PGM event, displayed in hh:mm:ss;ff (hours, 
minutes, seconds and frames). Unless the event is PGM, this field displays the fixed total 
duration.

The duration of a header event is equal to the sum of its sub-events - when PGM, the duration 
of the header event counts down in parallel with each sub-event.

Depending on the Material Decorator setting (refer to page 168) and the Duration Mode 
(refer to page 191) of the event, it may or may not be possible to change the duration.

To change the duration, double-click on the Duration field.

3.2.6.1 Changing the Duration of the On-Air Event

It is not possible to change the duration of the on-air event using that event’s Duration 
column - the duration is changed as follows:

1. Right-click on the on-air event and choose Edit Duration.

2. The Programme event editor dialog box is displayed, showing the current channel 
and on-air event title.

Note: Use caution when increasing the duration - it is possible to result in playing out black. 
Decreasing the duration truncates the item.

Note: It is not possible to edit the duration of the PST event within the preroll time of that events’ 
devices.

Figure 18    Programme Event Editor Dialog Box - Edit Duration
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3. Perform one of the following actions:

• To change the duration of the event, select Edit duration, under Set duration 
(Figure 18). Enter the required duration in the New duration field.

• To change the event’s end time, select Edit end time, under Set end time ().If 
required, enter a new date in the field provided or click on the arrow on the date 
field and select the date from the calendar. In the time field, enter the required 
end time.

4. Click on OK.

Note: If the new duration is shorter than the time that has already played out, or if the new end 
time is in the past, an error message is displayed.

Figure 20    Programme Event Editor Dialog Box - Edit End Time
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3.2.7 Event Field: Secondary Content

If a primary event has secondary events associated with it, one or more icons may appear in 
this field (refer to ‘Primary and Secondary Events’ on page 108). These icons show the 
number and type of secondary events.

There are many types of secondary event. Four examples are shown in the following table. 
The icons in the Editor Window may differ from those in Table 3 (examples only).

The background color of the secondary event icon indicates the status of the secondary 
event. The following table shows each possible icon background color.

Note: If a secondary event has further secondary events, these are indicated in its 
Secondary Content field.

Icon Description

DSK event. Refer to ‘DSK Events’ on page 110.

DVE event. Refer to ‘DVE Events’ on page 110.

GPI event. Refer to ‘GPI Events’ on page 110.

Audio over event. Refer to ‘Audio Over Events’ on page 111.

Table 3   Icons for Different Secondary EventTypes

Icon Description

None The event is in the future and will play.

Red There is a problem with the event, such as a device allocation 
conflict. It will not play.

Green The event is playing out.

Greyed out The event is in the past (the parent event may still be playing out).
Table 4   Secondary Event Status Color
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3.2.8 Event Field: Source

Displays the source on the first line, such as a server port or VTR, from which the event plays 
out - the device name is displayed on the second line.

To change the source, double-click on the Source column and select the required device 
from the list.

3.2.9 Event Fields: Main & Guard (Grd)

The Main and Grd columns show the status of each event on the main and guard source 
(refer to ‘Guard Source’ below) by means of barrels (refer to ‘Status Barrels’ below) and a 
transfer progress bar.

3.2.9.1 Guard Source (Grd)

A guard source:

• Is an alternative playout device that can be selected if there is fault with the main 
source. 

• Provides resilience and minimizes any disturbance to the channel output.

• Is associated with a device, not an event.

• Plays out the material at the same time as the main source.

• Can be selected from the Manual Intervention Panel by clicking Take Guard Pro-
gramme (refer to ‘Manual Intervention Panel’ on Chapter 5. Manual Intervention 
Panel (MIP) and Section 5.2.5 TAKE GRD PGM (Take Guard Programme).

• It is possible to toggle between the main and guard sources using the Toggle Guard 
option in the right-click menu in the Editor.

• Can be invoked for the preset event by clicking Take Guard Preset in the MIP (refer 
to ‘Take Guard PST’ on page 101).

• Remains activated for every event that uses that device, until it is deactivated.

Note: Second line information may have been suppressed in the configuration.

Note: The source can be changed using the Property Inspector if the system configuration allows 
it (refer to ‘The Property Inspector’ on page 166 and ‘Main Video Source/Main Audio 
Source’ on page 190).

The source for one or more events can be changed using ‘Search and Replace’ (refer to 
page 15).

Using ‘ripple’, events can be played out from a schedule from alternate playout devices or 
server ports (refer to ‘Rippling a Schedule’ on page 52).

Note: If the guard is activated, its use is recorded in the as-run log (refer to page 93).
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3.2.9.2 Status Barrels

The Main and Grd columns show one or two barrels for each event:

• The left-hand barrel indicates the ‘material status’ of the item in the Morpheus media 
management database (refer to page 212). This is determined by the Material Deco-
rator’ (refer to page 215).

• The right-hand barrel indicates the device status of the item as reported by the Bridge 
(refer to ‘Device Status’ on page 209 and ‘Bridge’ on page 209).

• If the two barrels are the same color they are combined into one larger barrel.

• If the barrels indicate that an event will not play, the following icon is displayed next to 

the column heading: 

The table below shows each barrel colour and its meaning.

Status 
Barrel(s)

Description

There is no response from the Material Decorator or Bridge.

The event will not play out for either of the following reasons:

• There is content on the device but no response from the Bridge.

• The event is outside the look-ahead period (refer to ‘Event Look Ahead’ 
on page 210).

If automation is off, the entire schedule has this status.

The event will play out but the material decorator is no longer responding.

The content is not on the specified device. A transfer request has been issued 
(refer to ‘Transfer Decorator Service’ on page 215).

The database contains content metadata only. No recordings exists.

The transfer has failed. The content is not on the server.

The material is neither in the database or on the playout device.

The database reports that there is content on the specified device but the device 
reports it as missing.

A transfer is in progress.

Table 5   Status Barrels
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The event will not play for one of the following reasons.

• The content is not on the specified device and no transfer is available.

• The device controller has failed (refer to ‘Device Controller Card’ on 
page 208).

• The device controller is restarting.

If the entire schedule has this status, the mixer has failed.

The event will play.

The event is cued.

The event is on air.

The event has finished and is waiting to be collected.

Note: Display further information about the status barrels using the ‘event status report’ (refer to 
page 39).

Status 
Barrel(s)

Description

Table 5   Status Barrels
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3.2.9.3 Transfer Progress Bar

Morpheus can display a Transfer Progress bar on the Main and Guard columns - it is updated 
by the Video Network Manager and Archive Controller applications. This provides a more 
accurate prediction of when the material becomes available on the required device.

To configure this feature, refer to the Morpheus Engineer’s Manual.

Once the progress bar is configured, create a schedule item that requires an item of material 
to be transferred to a new device. The progress bar is displayed behind the material barrel as 
shown below:

If the material is being transcoded, the Transfer Progress Bar is displayed as shown below:

3.2.10 Event Field: Notes

If an icon is displayed in the Notes field, this indicates that a note has been added to the 
event.

• To view the note, double-click on the note icon.

Note: Display further information on the Main and Guard fields using the ‘Event Status Report’ 
(refer to Section 3.3 Event Status Report).

Figure 21    Transfer Progress bar

Figure 22    Transcoding Progress bar

Note: A note can be added to the event using the Notes field on the Property Inspector (refer to 
‘The Property Inspector’ on page 166 and ‘Notes’ on page 190).
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3.2.11 Event Field: QC

This shows the QC (Quality Control) status of all the video events on the playlist. This status 
is taken from the Morpheus media management database (refer to page 212). The icons 
show whether the material for transmission has been checked and is suitable to go to air.

The following table shows each possible QC icon.

Icon Description

If there is any late delivered material that has not been checked, this icon 
encourages the operator to review the material before it is transmitted.

This indicates that the material has been quality checked but not content 
reviewed.

This shows that the material has been content reviewed but not quality checked.

This shows that the material has been reviewed and checked.

This shows that the material has been checked by the Morpheus Quality 
Manager application.

Table 6   QC Icons
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3.2.12 Event Field: Validation

The Validation field shows icons indicating errors or information associated with an event.

By default, if an event has no errors or there is no information available, the event's 
Validation field is left blank. However, the system may have been configured to show an icon. 
The default icon is as follows:

The system may be configured to show only a single icon in the Validation field. In this case, 
the highest (most serious) error level is shown. Alternatively, more than one icon may be 
seen, with the highest level on the left, the second highest level next to it and so on.

The following table shows the icons that may appear in the Validation field. These are the 
default icons and may differ, depending on the system configuration.

Icon Description

Critical.

Error.

Warning.

If the system is not configured to show an icon indicating an error or warning, or if 
the appropriate icon is not available on the workstation, this icon is displayed in 
the Validation field. This indicates that there is a validation error or warning.

Information.

Displayed in the Validation field when a Mix or Wipe transition are selected (refer 
to Section 3.2.5 Event Field: Mix) that use the same source as the previous main 
event source. If a different source is selected, the icon is no longer displayed 
(refer to ‘Source’ on Section 3.2.8 Event Field: Source).

Note: Depending on the configuration of the editor, this icon may be suppressed.

Indicates that the event’s inpoint is earlier than the Morpheus media management 
database inpoint (refer to ‘Inpoint’ on page 185 and ‘Morpheus Media 
Management Database’ on page 212).

Note: Depending on the configuration of the editor, this icon may be suppressed.

Indicates that the event’s inpoint is offset from (later than) the database inpoint.

Note: Depending on the configuration of the editor, this icon may be suppressed.

Indicates that the event’s outpoint is later than the database outpoint so the clip 
may freeze for the duration of the event.

An event’s outpoint determines at what timepoint, in the tape item or server file, 
the device stops playing. This would usually be 00:00:00:00 (hours, minutes, 
seconds, frames) for a server event or 10:00:00:00 for a tape event (depending 
on the station’s method of working).

Note: Depending on the configuration of the editor, this icon may be suppressed.
Table 7   Validation Icons
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3.2.13 Event Field: Date

The Date field shows the start date for the event. This date can be changed on the Property 
Inspector if the event is a fixed event. The date is displayed as dd-mmm-yyyy as shown 
below:

Note: Display further information about the validation icons using the ‘Event Status Report’ (refer 
to Section 3.3 Event Status Report).

If the duration of opt breaks in regional channels differs, icons may appear in the 
Validation column to indicate this. Refer to ‘Opt Header’ on page 112 and Chapter 7.6.3 
Duration Mismatch.

Figure 23    Date Field
Issue 1 Rev. 2 Page 39



Morpheus V4.6 Schedule Columns
3.2.14 Event Field: Thumbnail

This column contains a thumbnail image of the material from a Momentum system as shown 
in the example below:

If the Material ID for the event is a valid Material ID in the Momentum system and a thumbnail 
image exists, it is displayed in the Thumbnail column.

If the Material ID for the event is a valid Material ID in the Momentum system but it does not 
have a thumbnail image, the default icon is displayed as shown in first event above.

If the Material ID for the event does not exist in the Momentum system, the column is empty.

To view a clip in a player, double click on the thumbnail. The player is displayed as follows:

The usual viewing options are available on the player (play, stop, fast forward, etc.) - these 
can be used to view the clip in the Editor.

Figure 24   Thumbnail Column

Figure 25   Thumbnail Player
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Additionally, the following options are available:

If the Player is currently open, the thumbnail image of the currently playing clip has a yellow 
border.

3.2.15 Event Field: Duration Aired

The amount of time over which the event has actually aired, counting up from its start time, 
and taking into account any overrun - it is displayed in hh:mm:ss;ff (hours, minutes, seconds 
and frames). Unless the event is PGM, this field displays 00:00:00;00.

The duration of a header event is equal to the sum of its sub-events - when PGM, the duration 
of the header event counts up in parallel with each sub-event.

Option Description

Mark In - Enter a timecode to set a new Mark In value for the clip. This value 
is not set in the Morpheus event until the user clicks the OK button. The value 
updates the schedule, therefore, ensure that the event is set to Decorate 
Once. 

Mark Out - Enter a timecode to set a new Mark Out value for the clip. This 
value is not set in the Morpheus event until the user clicks the OK button. The 
value updates the schedule, therefore, ensure that the event is set to 
Decorate Once.

Seek frame - Enter a frame timecode then click Go!, in order to jump to that 
frame in the player.

Current frame timecode - This is the timecode for the current frame.

Table 8   Additional play options
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3.3 Event Status Report

The ‘event status report’ shows information relating to the Main, Guard and Validation event 
columns. To display the status report for a particular event, double-click in its Main, Guard, or 
validation fields.

The entries are colour coded as follows:

• Green text - information only 

• Orange text - warning

• Red text - error

Select the Hide entries that are ok check box to hide information only entries (green text). 
Clear the check box to display all entries.

Figure 26    Event Status Report
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4. Working with Events on the Schedule

This section contains information on working with events on the Editor schedule. The events 
that are visible to an operator depend on the Editor configuration settings for the role.

4.1 Highlighting Events

Highlight one or more events in the schedule in order to perform an action:

• To highlight a single event, click that event.

• To highlight a range of events, hold down the Shift key while clicking the first and last 
event.

• To highlight all events on the schedule, click on the top event on the schedule and 
from the Edit menu, choose Highlight to End.

4.2 Moving Around the Schedule

• To move to the bottom of the schedule, press End or click Go to Bottom on the tool-
bar.

• To move to the top of the schedule, press Home or click Go to Top on the toolbar.

• To move to the next page, press Page Down.

• To move to the previous page, press Page Up.

Note: The background color of an event depends on the configuration of the Editor. For example, 
it is possible for an event background color to be red if it contains a validation error.
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4.3 Bookmarks

A bookmark labels an event so that it can be homed in on by an operator from anywhere in 
the schedule.

4.3.1 Applying a Bookmark

1. Highlight the relevant event.

2. Right-click on the highlighted event.

A dark green highlight is displayed to the left of the event.

3. Choose Toggle Bookmark.

4.3.2 Moving to a Bookmarked Event

1. Right-click an event on the schedule.

2. Choose either Choose Go To Next Bookmark or Go To Previous Bookmark. If 
necessary, repeat until the required event is found.

4.3.3 Removing a Bookmark

1. Right-click on the relevant bookmark.

2. Choose Toggle Bookmark.
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4.4 Changing the Order of Events

Events can be moved or copied from one area of the schedule to another by using Cut/Copy 
and Paste/Paste Top. Additionally, the Cut/Copy and Paste/Paste Top function can be 
applied to a whole schedule (based on the Schedule Information Object ID). Be aware that 
these functions must be selectively enabled in the Editor Configuration window, and therefore 
may not be available for use.

4.4.1 Moving Events

1. Highlight the event(s) to move, and do one of the following:

• From the Edit menu choose Cut.

• Press Ctrl+X.

• On the toolbar, click Cut.

2. Depending on the configuration of the Editor, a confirmation dialog box may appear. 
Click Yes to continue.

3. Select the event below which to move the new event.

4. Do one of the following:

• From the Edit, menu choose Paste.

• Press Ctrl+V.

• On the toolbar, click Paste.

4.4.2 Copying Events

1. Highlight the event(s) to copy and do one of the following:

• From the Edit menu, choose Copy.

• Press Ctrl+C.

• On the toolbar, click Copy.

2. Select the event below which to copy the new event.

3. Do one of the following:

• From the Edit menu, choose Paste or press Ctrl+V.

• On the toolbar, click Paste.
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4.4.3 Moving/Copying Events After the On-Air Event

If required, one or more events can be moved or copied immediately after the on-air event - 
this action will move the preset event down the schedule.

1. Select the event(s) to move and do one of the following:

• From the Edit menu, choose either Cut or Copy.

• Press either Ctrl+X (to move the events) or Ctrl+C (to copy the events).

• On the toolbar, click either Cut or Copy.

2. Depending on the configuration of the Editor, a confirmation dialog box may appear. 
Click Yes to continue.

3. Do one of the following:

• From the Edit menu, choose Paste Top.

• Press Ctrl+N.

4. On the toolbar, click Paste Top.

4.4.4 Paste Sibling

The Paste Sibling option is available from the right-click menu. It allows a main event to be 
moved to a position underneath another main event.

• A main event is a top level event. Some events can be at a lower level - these are 
called ‘secondary events’ (refer to page 108).

• A sibling event is an event that is at the same level as another event.

To move or copy the sibling event:

1. Highlight the event to move or copy.

2. Right-click on the event and choose either Cut or Copy.

3. Highlight the event below which to paste the new event.

4. Right-click on the event and choose Paste Sibling.

4.4.5 Paste Child

The Paste Child option allows the moving or copying of a child event from one parent event 
to another parent event (refer to ‘Primary and Secondary Events’ on page 108 and 
Parent/Child Relationships on page 109).

To move or copy the child event:

1. Highlight the child event.

2. Right-click on the event and choose either Cut or Copy.

3. Highlight the parent event below which to paste the child event.

4. Right-click on the event and choose Paste Child.
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4.5 Deleting Events/Clearing the Schedule

4.5.1 Deleting Events

1. Select the event(s) to delete.

2. Press Delete on the keyboard.

3. If a confirmation dialog box is displayed, click Yes.

4.5.2 Clearing the Schedule

Clearing the schedule leaves the on-air event running but removes all other events from the 
schedule.

1. Do one of the following:

• From the File menu, choose Clear.

• On the toolbar, click Clear.

2. To confirm, click OK.

Important: Caution is required when deleting events or clearing the schedule as these operations 
cannot be undone. Depending on the configuration of the Editor, there may be no option to 
confirm deletion of events.
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4.6 Disabling / Enabling Events

If an event is to be prevented from running, it can be disabled as follows:

1. Highlight the event to disable.

2. Right-click on the event and select Disable Event.

The event is ‘hatched out’ and the following event runs normally.

3. To enable an event, select the event and then select Enable Event(s) from the 
right-click menu.

To disable multiple events, including events within break headers:

1. Use the Shift key to highlight multiple events

2. Right-click on the events and select Disable Events. The events are ‘hatched out’ 
and the following event runs normally.

3. To enable a set of events, select the events and then select Enable Events from the 
right-click menu.

Note: Alternatively, the keyboard shortcut Ctrl + Shift + D can be used to enable or disable the 
event.

Important: It is not possible to enable or disable an event that is in the past, equally, it is not possible 
to disable an event that has started it’s preroll.
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4.7 Force Validating an Event

Morpheus validates each event to ensure that the material is present and ready to play out. If 
it is necessary to play out an item of material at short notice, it is possible that the validation 
process is not completed before the event is cued. 

To force Morpheus to validate an event as quickly as possible:

1. Right click on the event.

2. Select Force Validate Events as shown below:

The Generic Validation Service validates the event as the highest priority.

Figure 27   Force Validate Events
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4.8 Track Program Event

By default, the on-air event is displayed above a red line at the top of the schedule. Directly 
below the line is a greyed out event which is the event that has just finished playing. Beneath 
the greyed out event, the on-air event is displayed again.

The display can be changed so that the preset event directly follows the on-air event. To 
achieve this, do one of the following:

• On the toolbar, click Track Program Event.

• Right-click any event on the schedule. From the menu, choose Track PGM Event.

• Press Ctrl+T.

On-air Event

Figure 28    Track Program Event

Past Event
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To return to the default display, do one of the following:

• On the toolbar, click:

• Right-click any event on the schedule. From the menu, choose Track PGM Event.

• Press Ctrl+T.

Note: The on-air event is frozen at the top of the schedule, above the red line, to ensure that it is 
always visible in the schedule, even when scrolling down.
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4.9 Rippling a Schedule

‘Rippling’ means playing out events on a schedule from alternate playout devices or server 
ports. The following examples demonstrate where rippling can be used:

• In a VTR based system where at least two machines need to play out alternately, rip-
pling allows time for tapes to be changed. If a series of very short files (1 or 2 sec-
onds) are to play out, three or more ports could be necessary.

• In server based systems where a server port needs a certain time (preroll) to guaran-
tee a stable output.

Rippling allows an operator to choose a mixer transition, such as a wipe or crossfade - it 
requires two sources to be on air at the same time, so it is not possible in a system with a 
single server port.

Rippling distributes the load evenly between devices or ports.

4.9.1 How to Ripple a Schedule

1. Highlight the events to ripple (refer to page 43).

2. Do one of the following:

• From the Tools menu, choose Ripple.

• On the toolbar, click Ripple.

The Select a Ripple dialog box is displayed.

3. From the list on the left, select the devices to ripple.

4. From the Options pane, select the required check boxes.

5. Click OK to ripple the schedule and assign the events to alternate ports.
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4.10 Saving and Loading Schedules

4.10.1 Saving a Schedule for the First Time

1. Do one of the following:

• From the File menu choose Save As.

• On the toolbar, click Save As Schedule.

The Save As dialog box is displayed. By default, the drive and folder are set to 
C:\EventstoreExport.

2. In the File name box, type a name for the schedule and click Save.

4.10.2 Updating a Schedule

To update a schedule, do one of the following:

• From the File menu, choose Save.

• On the toolbar, click Save.

Note: It is recommended that Save As is used rather than Save to update a schedule. If loading 
a schedule from a previously saved file, which is then modified, Save overwrites the file, 
which may not be desirable. Because of this, some systems have the Save option 
disabled.
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4.10.3 Loading a Schedule

Load Schedule keeps the on-air event running and replaces all remaining events with the 
new schedule. It is therefore recommended that care is taken when using this option.

If the loaded schedule begins with a fixed event, that event is placed in the future on the first 
date that has that time slot available (refer to ‘Follow-on and Fixed Events’ on page 117).

If the loaded schedule has a fixed event later on, that event and events following it are 
delayed to the first date that has that time slot free.

To load a schedule:

1. Do one of the following:

• From the File menu, choose Open.

• On the toolbar, click Load Schedule.

The Replace Schedule dialog box is displayed.

2. Browse to the required drive and folder.

3. Select the schedule from the list and click Open.

Depending on configuration of the Editor, Morpheus can display a confirmation warning 
(shown below) on the Editor when the operator attempts to replace all events on a channel.

Figure 29    Load Confirmation Warning
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4.10.4 Appending a Schedule

Append Schedule places the selected schedule after the last event on the current schedule.

Appending is useful when a schedule for the next day or time period has been created and 
saved offline. It appends the next day’s schedule to the current day’s schedule.

If the appended schedule has fixed events, these are assigned the first date with the fixed 
start time free. Subsequent follow-on events follow on from them (refer to Follow-on and 
Fixed Events’ on page 117).

To append a schedule:

1. Do one of the following:

• From the File menu, choose Append.

• On the toolbar, click Append Schedule.

The Append Schedule dialog box is displayed.

2. Select the schedule to append and click Open.

Depending on configuration of the Editor, Morpheus can display a confirmation warning 
(shown below) on the Editor when the operator attempts to append a schedule that is already 
loaded in the Editor.

Click OK to append the schedule. Morpheus allocates the schedule a new Schedule Name. 
By default the system appends the schedule name with a number, starting with 1 - for 
example, the schedule in Figure 30 will be allocated the name ‘Default Schedule(1)’.

Figure 30    Append Schedule Confirmation Window
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4.10.5 Inserting a Schedule

The Insert option inserts a schedule into the current schedule or an offline schedule.

To insert a schedule:

1. Highlight the event below which to insert the schedule.

2. Do one of the following:

• From the File menu, choose Insert.

• Right-click any event on the schedule. From the menu, choose Insert schedule. 

The Insert Schedule dialog box is displayed.

3. Select the drive and folder containing the schedule to insert.

4. Select the required schedule and click Open.

4.10.6 Creating and Saving Schedules in the Offline Editor

A schedule can be created and then saved in the Offline Editor for loading (or appending) into 
the live schedule in the Online Editor.
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4.11 Multiple Schedules

When the Editor contains more than one schedule at a time, it can be difficult to see where 
one schedule ends and the next one begins. In order to differentiate between schedules, 
Morpheus displays a color-coded bar on the left-hand side of the Editor grid.

These colors appear because the schedules contain schedule object information. Morpheus 
displays this information in the Schedule Object Inspector. 

In the example above, the first schedule has a green bar. The second schedule has a lighter 
green bar. Morpheus uses alternate colors if there are more than two schedules in the Editor.

Bookmarks appear on top of the schedule bar color in dark green as shown below:

For further information, refer to Section 9.11 The Schedule Object Inspector.

Figure 31   Schedule Indicators

Second schedule 

First schedule 

Figure 32    Bookmark in a Schedule

Bookmark
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4.12 Event Summary

The ‘event summary’ schedule statistics to be viewed, such as the number and total duration 
of commercials in a schedule.

To display the event summary:

1. Highlight the required events or the whole schedule (refer to page 43).

2. Right-click any event on the schedule.

3. From the menu, choose Display summary.

The Event Summary window is displayed, listing, for each type of material, the num-
ber of events, the total duration, in hours, minutes, seconds and frames, and the per-
centage of the total number of events.

Figure 33   Event Summary Window
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4.13 Hourly Summary

The Hourly Summary option allows the production of a report showing the percentage per 
hour, over a 30 hour period, during which a particular material type is used. To produce an 
hourly summary report:

1. From the Tools menu, choose Hourly Summary.

The Hourly Content Summary window is displayed.

2. Select a material type from the Material type to summarise list:

• Programme - Main programme items

• Commercial - Revenue-generating advertisements

• Junction - Channel idents and other interstitials

• Live - A live studio item

• Live record - An item that was recorded live or crash recorded and may contain, 
for example, unexpected black.

3. Click Update.

Figure 34    The Hourly Summary Window
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- Preview 

Display the format of the document prior to printing.

- Print

Send the contents of the Hourly Content Summary window to a printer - a print dialog box 
is displayed.

- Print Colour

Tick the checkbox if colour printing is required.
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4.14 Operating Channel Flow Control-Join In Progress (CFC-JIP)

Once configured, CFC-JIP functionality is accessible from two different locations:

In the Morpheus Editor (Workstation)

- Dead-Roll the selected show on the current channel

- Dead-Roll from the beginning of a selected event, for a specific period of time

- Take Live

From the CFC Interface or the Combined CFC Interface

- Dead-Roll an entire Show

- Take Live All

- Rejoin

- Rejoin All

Note: The Take Live All and Rejoin All functions are provided on buttons at the bottom of the 
Combined CFC Interface, and are additional to the functions that operate on each 
individual CFC interface in the same window.

Note: Rejoin functionality is only provided on the CFC / Combined CFC interface - it is not 
available from the Morpheus Editor menu system.
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4.14.1 Terminology

Source Channel

The active channel, running the on-air schedule.

Origin Event

The original events on the Source Channel.

Staging Channel

The isolated channel on which the Dead-Roll is performed. A Dead-Roll consists of either 
a number of events, or a show, selected from the Source Channel. A Staging Channel is 
bound to a single Source Channel, and it can operate in exactly the same way, except that 
no events on a Staging Channel will ever go to air.

Dead-Roll

The mechanism by which the chronology of a schedule is preserved by running a 
matching set of events from a Source Channel on a Staging Channel. Events in the 
schedule on the Staging Channel are not broadcast.

The duration of a Dead-Roll is selectable from a set of predefined options:

• An entire ‘Show’

• 30, 60, or 90 minutes of the schedule

For details, refer to Section 4.14.3.1 Dead-Roll Using the Morpheus Editor (Workstation).

Take Live / Take Live All

A function that is designed to interrupt the current scheduled event on the Source Channel 
by switching to a live event from an alternative source - a Take Live can be performed on 
the selected channel (that which is currently in view in the Editor) or on multiple channels 
simultaneously by performing a Take Live All.

• A Dead-Roll is performed on the current ‘Show’ and the system ‘Takes into’ the 
live event. The duration of the live event inserted into the Source Channel sched-
ule is preconfigured, although this is a nominal value only- the PST event is set to 
Manual Take, therefore the live event has the Hold flag set

• The duration of the Dead-Roll is preconfigured

• Resume the schedule at a selected point in time during the live event by perform-
ing a rejoin within the Rejoin Timeframe.

Note: It is not possible to load a schedule directly onto the Staging Channel outside of the 
CFC-JIP process.

A Dead-Rolled schedule on the Staging Channel may be modified if either Dynamic Rejoin 
modes have been selected (refer to Section 4.14.5 Rejoin Modes) - any modification to the 
part of the schedule on the Source Channel that has been Dead-Rolled Channel will be 
overwritten upon a rejoin.
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Rejoin

The Join In Progress. Events from the Dead-Roll Set on the Staging Channel provide the 
means of resuming the original schedule at the point at which it would have been had it not 
been interrupted, and in accordance with the selected rejoin mode. The nature of the 
rejoin can be selected:

• Single Rejoin - applies only to the selected channel

• Group Rejoin (gang rejoin) - applies to multiple channels

Channel Flow Control (CFC)

The mechanism that uses the Source / Staging Channel pair to perform the Dead-Roll, 
Take-Live and Rejoin functions.

Dead-Roll Set

The group of events that have been Dead-Rolled on the Staging Channel prior to a rejoin 
instruction (whether or not one occurs).

Rejoin Timeframe

Applies to all rejoin modes.

The duration of the Dead-Roll Set, within which it is only possible to perform a rejoin (i.e 
from the PGM on the Staging Channel to the end of the Dead-Roll). The Rejoin Timeframe 
diminishes as events on the Staging Channel are Dead-Aired.

Modifying the Dead-Roll Set
If events on the Staging Channel are altered following the Dead-Roll, then the Rejoin 
Timeframe will change according to the duration of those events - in this case, only the 
dynamic rejoin modes are supported. Due to its nature, a Mapped Rejoin must not be 
attempted if events on the Staging Channel have been modified.

Dead-Airing

The action of running a schedule on the Staging Channel without broadcasting the events.

Counterpart Event

A duplicate of an Origin event - they appear on the Staging Channel as events in the 
Dead-Roll Set, and on the Source Channel following a dynamic rejoin.

Regardless of the selected rejoin mode, a rejoin is only possible for the duration of the 
Dead-Roll.
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Calculated Rejoin Event

The Main Event that has been selected by the Rejoin Calculation as the candidate to lead 
in the rejoin process - depending upon the selection criteria of the Rejoin Calculation, any 
Candidate Event (including the Natural Rejoin Event) could be selected.

Rejoined Event

The first event to air on the Source Channel after the Bumper Event, following a rejoin.

Preserved Event

An event that is identified when a Dead-Roll Set has not yet fully expired and a Preserved 
rejoin instruction is issued. It describes Origin Events on the Source Channel that are 
within the boundaries of the Rejoin Timeframe; they are subsequently disabled by the 
system and displaced to a position below the events copied from the Staging Channel, in 
between the first Dead-Roll End Marker (copied from the Staging Channel) and the last 
Dead-Roll End Marker (the original Source Channel End Marker). As Origin Events, they 
can be enabled if required in order to replace the Counterpart Events copied from the 
Staging Channel (in which case the Counterpart Events should be disabled).

Residual Event

An Origin Event that was included in Dead-Roll and will remain on the Source Channel 
after a rejoin has been performed in the following situations:

• When an event has overrun on the Source Channel

• When the duration of the Rejoin Timeframe has been purposefully reduced (for 
example if one or more events have been deleted from the Dead-Roll Set)

• A combination of an overrun on the Source Channel and a reduction in the dura-
tion of the Rejoin Timeframe

The number of Residual Events present on the Source Channel will depend on the states 
of the Source and Staging Channels at the point of the rejoin, such as:

• The remaining duration of the Rejoin Timeframe

• The duration of the Source Channel event overrun

For detailed information on the dynamic rejoin mode, refer to Section 4.14.5.1 Override 
Mode and Section 4.14.5.2 Preserved Mode.

Note: Unless there are very short events in the schedule, it is likely that the Calculated Rejoin 
Event will be either the PGM of the PST event on the Source Channel.

Note: Residual Events will only be present when a dynamic rejoin mode is used (Override or 
Preserved)

In most cases, it will be desirable to manually delete all Residual Events following a rejoin - 
this is particularly relevant if scheduled time is to be resumed on the Source Channel.
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Bumper Event

The event that is broadcast on the Source Channel schedule, ahead of the Rejoined 
Event, to inform the end viewer that the scheduled events are about to resume. The 
Bumper Event could be a logo, graphic, or a clip from an evergreen source.

Rejoin Delay

A fixed amount of time used in the Rejoin Calculation to allow for the following:

• The normal schedule to be resumed according to the selected rejoin mode

• The held PGM to finish playout, the duration of which is defined by the parameter 
‘Min. Remaining Time of Held Event’

• The source device to prepare to play the Bumper event

Bumper Duration

The duration over which the Bumper Event will be played, as determined by the Rejoin 
Calculation - it is set in the configuration at a fixed minimum, however it may be extended 
by the Rejoin Calculation as required.

The Rejoin Calculation must take account of the actual duration of the Bumper Event.
Issue 1 Rev. 2 Page 65



Morpheus V4.6 Working with Events on the Schedule
4.14.2 CFC Markers

Markers are disabled main events of zero duration that are used only by the CFC in order to 
perform Dead-Roll and Rejoin functions, and to provide visual cues in the Editor.

Marker types:

• CFC DeadRoll Start

• CFC DeadRoll End

• CFC Rejoin Marker

All marker event types are created by the CFC system if they do not already exist, and are 
assigned to a Source and Staging Channel pair as required - no further configurations are 
required in this respect.

All markers are used by the Host Shell Service ‘Channel Flow Control Service’.

Note: If the AsRun or Journal have been configured, then these markers will also be recorded.

CFC markers must not be deleted from the Staging Channel; they may be only be deleted 
from the Source Channel after the completion of a Rejoin.

Figure 35   CFC Markers Example (Override Mode)
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4.14.2.1 Dead-Roll Markers

Dead-Roll Marker events are inserted into the schedule and are visible from any EventStore 
access point: the Workstation, EventStore Test, MultiHUD, etc.

Dead-Roll Start Marker

Regardless of the rejoin mode, a Dead-Roll Start Marker will only appear on the Staging 
Channel - it is positioned directly above the first event, or part thereof, that has been 
Dead-Rolled.

Dead-Roll End Marker

At the point of the Dead-Roll, and Regardless of the rejoin mode, a Dead-Roll End Marker will 
appear on both the Source Channel and the Staging Channel in order to indicate the extent of 
the Dead-Roll.

During a Dead-Roll, the Dead-Roll End Marker on the Source Channel will display its original 
scheduled start time above a current start time (which will ripple if the Source Channel is on 
hold) - these are used for reference purposes only.

Every time a new Dead-Roll is performed, new markers are created.

4.14.2.2 Rejoin Marker

A marker to identify the end of the rejoin, positioned immediately after the last event in the 
Dead-Roll Set and before the Dead-Roll End Marker.

This marker will only appear on the Staging Channel - it is only for use by the CFC-JIP 
system, and has no other purpose.

If Dead-Rolling for a fixed period of time, the system will never insert a Dead-Roll End 
Marker mid-event; it will always be positioned after the last event that falls entirely within 
the duration selected for the Dead-Roll, thus shortening the duration of the Dead-Roll. 
Refer to Chapter 4.14.3 Using CFC-JIP in the Morpheus Editor.

Note: When using a Dynamic rejoin mode, at the point of a rejoin the Dead-Roll End Marker will 
be duplicated on the Source Channel: one created at the point of the Dead-Roll, the other 
copied back from the Staging Channel. This does not occur when using Mapped Mode, as 
the process does not copy events from the Staging Channel.
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4.14.3 Using CFC-JIP in the Morpheus Editor

The Morpheus Editor offers a menu system for the selection of CFC-JIP functions.

4.14.3.1 Dead-Roll Using the Morpheus Editor (Workstation)

The mechanism by which the chronology of a schedule is preserved by running a matching 
set of events from a Source Channel on an isolated Staging Channel. Events in the schedule 
on the Staging Channel are not broadcast.

In the Editor, right click on an event in order to display a list of possible actions, then select 
Channel Flow Control > Deadroll.

The following options are available:

- Show

Dead-Roll the entire show in which the selected event is contained.

The Dead-Roll end marker will be positioned immediately after the last event in the Show.

Figure 36   CFC Dead-Roll Options
Issue 1 Rev. 2 Page 68



Morpheus V4.6 Working with Events on the Schedule
- From Event

Dead-Roll the part of the schedule from one of the following starting points, and for a fixed 
period of time:

• From the beginning of the selected event, if it has not yet gone to air

• From the current time if the event is already PGM

Select one of the following fixed period time intervals for the Dead-Roll: 30, 60, 90 
minutes.

Note: Apart from the first event, all others will only be included in the Dead-Roll for their full 
duration - the last event to be included will be the one that has a duration that is closest to 
the end of the selected Dead-Roll time interval, without going over.

The Dead-Roll End Marker will be positioned at the end of the last event included in the 
Dead-Roll - the marker will neither split an event, nor will it be positioned beyond the expiry 
of the selected time interval.

If a Dead-Roll is performed on a channel whilst another Dead-Roll is already in progress, 
then the existing one will be overwritten.
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4.14.3.2 Take Live Using the Morpheus Editor (Workstation)

A function that is designed to interrupt the current scheduled event on the Source Channel by 
switching to a live event from an alternative source - a Take Live can be performed on the 
selected channel (that which is currently in view in the Editor) or on multiple channels 
simultaneously by performing a Take Live All. A Dead-Roll is performed on the current ‘Show’ 
and the system ‘Takes into’ the live event. The PST event is set to Manual Take, therefore the 
live event has the Hold flag set.

In the Editor, right click on an event in order to display a list of possible actions, then select 
Channel Flow Control > Take Live.

This menu option performs the same function as a Take Live using the CFC interface (refer to 
Chapter 4.14.4.4 CFC Interface: Take Live).

Figure 37   Take Live Using the Morpheus Editor (Workstation)
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4.14.4 Using the CFC Interface

The CFC Interface is an independent control panel for performing Deadroll, Take Live and 
Rejoin functions, as follows:

• Dead-Roll an entire show. If Dead-Rolling from a point in time is required, refer to 
Section 4.14.3 Using CFC-JIP in the Morpheus Editor

• Take Live on a single channel

• Take Live on multiple channels simultaneously (system configuration dependent)

• Perform a rejoin according to the selected mode

• Perform a Rejoin All, i.e. rejoin multiple channels simultaneously

• Display CFC enabled channels within their own window, or as a combined view 
(system configuration dependent)

 CFC icon: click in order to display the CFC interface.

 CFC icon: click in order to hide the CFC interface.

Toggling the visibility of the CFC interface is applied on a per channel basis - the CFC 
interface for each Source / Staging Channel pair will be displayed in the same physical 
position (relocating one will automatically relocate the other).

Note: The CFC icon is only displayed on the tool bar if the system has been configured for CFC 
(i.e. at least one Staging Channel has been created and associated to a Source Channel).

Important: Visibility of channels in the Combined CFC Interface, and the availability of Rejoin modes 
is role dependant, and restrictions may have been imposed.
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Initial View of Single CFC Interface with no Activity

Single CFC Interface with Dead-Roll Active and Take Live Configured

Figure 38   Single CFC Interface - No Activity

‘Deadroll’ in bold: click to perform a Dead-Roll on this channel

The channel associated with this CFC Interface

Take Live and Rejoin function

(in this instance, no Dead-Roll is in progress on this channel, as

Information panel:
- Dead-Roll active / inactive

indicated by a greyed out Rejoin button)

buttons - Take Live is greyed out
as it has not been configured on
this channel. If the Rejoin button

Rejoin modes - greyed out in
this instance as there is no
Dead-Roll or Take Live in
progress

was illuminated and rejoin modes 
were in bold, it would indicate that
a Take Live is in progress

- Time before a rejoin is possible
- Next Event to Dead-Air

Figure 39   Single CFC Interface - Active Dead-Roll

‘Deadroll’ in bold: click to perform a Dead-Roll on this channel,
even though, in this instance, a Dead-Roll is already in progress
as indicated by the illuminated Rejoin button

Bumper details and material selection button (...)

Rejoin modes - in bold in
this instance as a Dead-Roll
is in progress

Ready to perform a Take Live.
In this instance it will override
the current Dead-Roll

Ready to perform a rejoin

PGM event on the Staging Channel, and its progress bar
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Single CFC Interface with Active Take Live

Combined CFC Interface

Multiple CFC interfaces combined into a single window (Figure 41) - the system has ‘Use 
Combined CFC Window’ parameter set, and channel 1 (CH1) and channel 2 (CH2) have the 
‘Combined CFC Channel’ parameter set in their configurations.

Note: A Take Live is not possible on either channel 1 or channel 2, in this instance, as it has not 
been configured (Take Live and Rejoin buttons are both extinguished).

Figure 40   Single CFC Interface - Active Take Live

Figure 41   CFC Interface - No Active Dead-Roll

The Dead-Roll command in bold indicates
that Channel 1 is currently in view on the
Workstation - it is only possible to run a
Dead-Roll on the channel in view
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Combined CFC Interface Displaying Group Channel Controls

As shown in Fig. 42, a Dead-Roll is in progress - the following options are therefore available:

• Perform a rejoin on a per channel basis according to the selected rejoin mode

• Perform a Rejoin All: all channels will rejoin simultaneously, and according to the 
rejoin mode selected for each channel

• Cancel the Dead-Roll - revokes a Dead-Roll, removing all events from the Staging 
Channel. If Preserve Aired Staging Events is enabled and the Staging Channel has a 
previously finished Dead-Roll Set, then it is retained, and only the currently active 
Dead-Roll Set is removed. This action has no effect upon the schedule on the Source 
Channel.

• Perform another Dead-Roll, overriding the active Dead-Roll

• Perform a Take Live, overriding the active Dead-Roll, if one exists

Figure 42   Combined CFC Interface - No Active Dead-Roll
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4.14.4.1 Bumper Information Pane

As well as displaying the identity of the Bumper source, the Bumper information pane 
provides the option of selecting an alternative Bumper material ID to that which has been 
preconfigured (Fig. 43).

Click on the ellipsis button (...) in order to display the Material ID Validator window and enter a 
new material Id for the Bumper Event. Click on OK to accept the new material Id, or Cancel to 
annul.

4.14.4.2 Rejoin Information Pane

An information pane is provided in the CFC interface to display the following information:

Deadroll not Activated

A Dead-Roll or a Take Live is not currently active on this channel - this message will also 
appear after a Dead-Roll has completed.

Rejoin Available In...

Displays the amount of time before which the first event in the Dead-Roll Set will begin 
Dead-Airing - a rejoin is not possible unless this time has been reached.

Next Event

The name of the PST event on the Staging Channel.

Note: The ellipsis button (...) is only visible for the duration of the current Dead-Roll.

The material Id for the Bumper Event must syntactically match one that exists in the Palette 
- there is no predictive help. The Material ID Validator is not case sensitive.

An alternative material Id entered via the CFC Interface will persist until the Editor 
Workstation is restarted, at which point the default Bumper Event material Id configuration 
will be applied.

The alternative Bumper Event material Id is only applied to the channel that is associated 
to the CFC Interface on which it was changed.

Figure 43   Selecting an Alternative Bumper Material ID
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4.14.4.3 CFC Interface: Dead-Roll

- Deadroll

Performs a Dead-Roll on the show that is currently selected (click on any event in the 
show in order to make the selection). If the show has not yet started, then all of its events 
are Dead-Rolled - if the show has already started, then all un-aired events (including the 
remainder of the current event) are Dead-Rolled.

- Cancel

Revokes the current Dead-Roll, removing all events from the Staging Channel, with the 
following exceptions:

• If Preserve Aired Staging Events is enabled and there remains a previously finished 
Dead-Roll Set on the Staging Channel, then it is not deleted

• If Preserve Aired Staging Events is enabled and a previously finished Dead-Roll Set 
remains on the Staging Channel whilst another Dead-Roll Set is Dead-Airing, then the 
active Dead-Roll Set is deleted.

If a Dead-Roll is performed whilst a previous Dead-Roll is still active, then the schedule 
from the first Dead-Roll will be overwritten by the second

Note: The Cancel function has no effect upon the schedule on the Source Channel.
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4.14.4.4 CFC Interface: Take Live

A function that is designed to interrupt the current scheduled event on the Source Channel 
by switching to a live event from an alternative source - a Take Live can be performed on 
the selected channel (that which is currently in view in the Editor) or on multiple channels 
simultaneously by performing a Take Live All.

• A Dead-Roll is performed on the current ‘Show’ and the system ‘Takes into’ the 
live event. The duration of the live event inserted into the Source Channel sched-
ule is preconfigured, although this is a nominal value only- the PST event is set to 
Manual Take, therefore the live event has the Hold flag set

• The duration of the Dead-Roll is preconfigured

• Resume the schedule at a selected point in time during the live event by perform-
ing a rejoin within the Rejoin Timeframe.

There are two possible Take Live actions:

• Take Live: performs a Take Live on the selected channel only (the selected channel is 
that which is currently in view in the Workstation)

• Take Live All: performs a Take Live on all channels that are configured for Combined 
CFC (function only available on the Combined CFC interface)

Function Buttons and Indicators

Take Live is currently configured for this channel, but has not been 
activated - press to Take Live.

Either a Take Live is in progress, or it is not currently configured on this 
channel, if a Take Live is in progress, the ‘Rejoin’ / ‘Rejoin All’ buttons will 
be highlighted)

Take Live is currently configured on at least one channel, but none have 
been activated - press to Take Live on all channels that are configured for 
this action.

Either a Take Live is in progress, or it is not currently configured on any 
channel - if a Take Live is in progress, the ‘Rejoin’ / ‘Rejoin All’ buttons will 
be highlighted.

Note: When a Take Live All is performed, the system ignores any channels that are currently in a 
Take Live state (i.e. their existing Take Live state will be unaffected.

If a ‘Take Live’ is performed during an existing Dead-Roll, then the Dead-Roll Set on 
Staging Channel will be overwritten by the events from the Take Live.

A Dead-Roll cannot be performed once a Take Live is active - the menu options are locked.
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4.14.4.5 CFC Interface: Rejoin

The ‘Join In Progress’. Events from the Dead-Roll Set on the Staging Channel provide the 
means of resuming the original schedule at the point at which it would have been had it not 
been interrupted, and in accordance with the selected rejoin mode

• Single Rejoin - applies only to the selected channel

• Group Rejoin (gang rejoin) - applies to multiple channels

•

The rejoin instruction could be issued from the CFC interface or, for example, from a 
Morpheus Access Panel (MAP) via a script.

Regardless of the selected rejoin mode, a rejoin is only possible for the duration of the 
Dead-Roll.

Figure 44   CFC Interface - Dead-Rolled Channels
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4.14.5 Rejoin Modes

Several modes are available that use different procedures to return to the Source Channel 
schedule:

• Override (a dynamic mode)

• Preserved (a dynamic mode)

• Mapped

A rejoin mode can only be selected once a Dead-Roll has been activated, but can be 
changed at any point up until a rejoin instruction has been executed.

The dynamic mode rejoin mechanisms, Override and Preserved, are based upon a period of 
time on the Staging Channel known as the Rejoin Timeframe, spanning from the PGM event 
to the end of the last event in the Dead-Roll. The rejoin process is responsible for any events 
that are the Rejoin Timeframe in order that they may be overlaid onto the Source Channel. 
The dynamic modes provide the facility to make changes to the Staging Channel Events, 
such as material Id, duration, source etc.

Using Mapped Mode, the Source Channel schedule is resumed at precise point in time.

Select a rejoin mode from the drop-down menu (Fig. 45) - the default is ‘Override’.

Note: Only those Rejoin modes that have been enabled during the configuration of the CFC-JIP 
functionality will be visible and available to use (‘Enabled Rejoin Modes’ parameter) - the 
configuration is applied on a per role basis.

Figure 45   Rejoin Modes on CFC Interface
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4.14.5.1 Override Mode

This is a dynamic mode that acts upon events that are within the Rejoin Timeframe (the length 
of time between the PGM event at the point of the rejoin instruction, to the end of the last 
event in the Dead-Roll Set). At the point of the rejoin, the events (or parts of events) that are 
within the Rejoin Timeframe will replace those on the Source Channel that occupy the same 
period of time. Any events on the Source Channel that are straddled by the end of the Rejoin 
Timeframe are deleted.

This is demonstrated in Fig. 46, where the Dead-Roll has been modified by deleting event 5, 
and increasing the duration of Event 4 by that of the deleted event. At the point of the rejoin, 
events 3 and 4 from the remaining Dead-Roll (the duration of which is the Rejoin Timeframe) 
will overwrite Origin Events 3, 4, and 5 on the Source Channel.

Override mode is designed to make it possible to modify the contents and the length of the 
schedule on the Staging Channel, during the Dead-Roll and ahead of the rejoin, allowing a 
different selection of events to be overlaid onto the Source Channel. The Rejoin Timeframe 
may be changed if events on the Staging Channel are modified.

Figure 46   Dynamic Rejoin Mode Concept
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In this second example (Fig. 47), event A2 has been allowed to overrun. At the point of the 
rejoin, events 3, 4, and 5 from the Dead-Roll will overwrite Origin Events 1, 2, and 3 on the 
Source Channel as they have been delayed by the duration of the overrun. This has the effect 
of leaving Residual Events in the Source Channel schedule, i.e Origin Events 4 and 5 - if they 
are not deleted, the material identified by these events will be broadcast twice (once from the 
Rejoined Events, and again from the Origin Events).

Note: The duration of the Rejoined Event is reduced in order to absorb the Rejoin Delay and 
accommodate the broadcast of the Bumper Event.

Note: If the Dead-Roll was initiated as a result of an overrun, and no changes are made to the 
schedule on the Source Channel or the Staging Channel, it is advisable to use Mapped 
Mode.

Note: The system generates a new OID each time a Counterpart Event is created. The OIDs on 
the Source Channel are unique, as are those of the Dead-Roll Set, and those that 
re-populate the Source Channel upon a rejoin.

Figure 47   Dynamic Rejoin Mode Concept Showing Residual Events
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Override Mode Example: Event Duration Extended On Staging Channel

The duration of Event 5 has been extended on the Staging Channel by 40 seconds (from 30s 
to 1m10s), prior to the rejoin, thus extending the Rejoin Timeframe.

Immediately prior the rejoin instruction, the Staging Channel appears as shown in Fig. 48.

Figure 48   Override Rejoin Example: Staging Channel Schedule (Dead-Roll)
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At the point of the rejoin, the following actions occur:

1. The Source Channel on-air event, event 3, plays out for the duration of the Rejoin 
Delay and is then followed by the Bumper Event.

2. The Counterpart events (3, 4, and 5), or parts thereof, from the Staging Channel that 
have not yet Dead-Aired are copied onto the Source Channel, replacing any events 
that fall wholly or partly within the Rejoin Timeframe - this results in events B1 and B2 
being deleted.

3. The PGM event from the Staging Channel, event 3, is then resumed on the Source 
Channel for its remaining duration, and is followed by all later events from the 
Dead-Roll.

4. The remainder of the schedule on the Source Channel, outside of the Rejoin Time-
frame, is resumed after the Dead-Roll End Marker, starting with event B3.

Note: The asterisks prepended to the Dead-Rolled events demonstrate that these are copies, 
and not the Origin Events.

Note: Event B3 onwards will not air according to their original scheduled time due to the event 
changes (increased duration of event 5 and the deletion of events B1 and B2).

Figure 49   Override Mode Rejoin: Event Extended on the Staging Channel

Staging Channel Source Channel
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Rejoin instruction issued during event 3 Bumper Event Events copied from Staging Channel

On-air event plays out for the duration of the Rejoin Delay
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4.14.5.2 Preserved Mode

Preserved mode is identical to Override mode, i.e. the rejoin is processed in the same way, 
except that it preserves the original events from the Source Channel that have been 
Dead-Rolled, and would otherwise be overwritten by Staging Channel Events at the point of 
the rejoin.

It is a suitable rejoin mode following an overrun, and / or modification of the events on the 
Source Channel or the Staging Channel (i.e. rejoining with a modified schedule).

This mode allows for, and requires, manual intervention in restructuring the schedule on the 
Source Channel once the rejoin has completed. The following options are available:

• Allow the Rejoined Event and the remainder of those events that have been imported 
from the Staging Channel to be broadcast. Residual Events should be deleted in order 
to avoid playing the same event content twice.

• Enable the Preserved Events in order for them to be reinstated, and disable or delete 
the events imported from the Staging Channel.

• Disable an event imported from the Staging Channel, replacing it with a Residual 
Event.

Note: Preserved mode is designed to provide the operator with the capability of resuming the 
schedule with the Origin Events.

Note: If the Dead-Roll was initiated as a result of an overrun, and no changes are made to the 
schedule on the Source Channel or Staging Channel, it is advisable to use Mapped Mode.

Note: If changes have been made to the Dead-Roll Set, then this mode can be used.

Note: The duration of the Rejoined Event is reduced in order to absorb the Rejoin Delay and 
accommodate the broadcast of the Bumper Event.

Note: Dealing with Time Link Declarations and Time Link References

Due to their nature, if present in a Dead-Roll Set, both Time Link Declarations and 
References are disabled by the Channel Flow Control system - they are labelled as such 
with the following suffix:

‘_CFC_DISABLED’

Upon a rejoin, the suffix is removed and the Time Links are enabled on the Source 
Channel.
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Preserved Mode Rejoin Example: Event Duration Extended On Staging Channel

The duration of Event 5 has been extended on the Staging Channel by 40 seconds (from 30s 
to 1m10s), prior to the rejoin, thus extending the Rejoin Timeframe.

Immediately prior the rejoin instruction, the Staging Channel appears as shown in Fig. 50.

Figure 50   Preserved Rejoin Example: Staging Channel Schedule (Dead-Roll)
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At the point of the rejoin, the following actions occur:

1. The Source Channel on-air event, event 3, plays out for the duration of the Rejoin 
Delay and is then followed by the Bumper Event.

2. The Counterpart events (3, 4, and 5), or parts thereof, from the Staging Channel that 
have not yet Dead-Aired are copied onto the Source Channel, replacing any events 
that fall wholly or partly within the Rejoin Timeframe - this results in events 4, 5, B1 
and B2 preserved in a disabled state.

3. The PGM event from the Staging Channel, event 3, is then resumed on the Source 
Channel for its remaining duration, and is followed by all later events from the 
Dead-Roll.

4. The remainder of the schedule on the Source Channel, outside of the Rejoin Time-
frame, is resumed after the Dead-Roll End Marker, starting with event B3.

Note: The asterisks prepended to the Dead-Rolled events demonstrate that these are copies, 
and not the Origin Events.

Note: Event B3 onwards will not air according to their original scheduled time due to the 
increased duration of event 5.

Figure 51   Preserved Mode Rejoin: Event Duration Extended on Staging Channel
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4.14.5.3 Mapped Mode Rejoin

This mode is designed to make it possible to resume schedule time on the Source Channel 
following an event overrun (such as an extended sports program or news bulletin).

It is a static mode that synchronises Origin Events on the Source Channel to the Dead-Rolled 
Counterpart Events on the Staging Channel in order to maintain an accurate one to one 
mapping - by referencing a single point in time in the Dead-Roll Set relative to an event at the 
point of the rejoin instruction, this mode identifies precisely where to resume an event on the 
Source Channel (the Rejoined Event) thereby preserving schedule time.

No events are copied from the Staging Channel when using the Mapped Rejoin mode - the 
Rejoined Event, and all that follow, are the Origin Events on the Source Channel.

For information relating to the CFC Markers, refer to Section 4.14.2 CFC Markers.

Important: Mapped mode offers the highest performance, and is recommended for use in all rejoin 
cases. A Mapped mode rejoin will fail if changes have been made to the schedule on either 
the Source Channel or the Staging Channel, with one exception: a Mapped Rejoin is 
supported following a Take Live, despite the insertion of an event onto the Source Channel.

Note: The duration of the Rejoined Event is reduced in order to absorb the Rejoin Delay and 
accommodate the broadcast of the Bumper Event.

Note: Events on the Staging Channel are Counterparts of the Origin Events on the Source 
Channel, and as such they are allocated new OIDs. A table is maintained by CFC in order 
to associate the OID of the Origin Event with that of the Counterpart Event. In Mapped 
Rejoin mode, the Dead-Roll is only used as a time reference for the rejoin, the Origin 
Events will always retain their original OIDs.

Figure 52   Mapped Rejoin Mode Concept
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Mapped Rejoin Example: Overrun on Source Channel

At the point of the Dead-Roll instruction, the Staging Channel appears as shown in Fig. 53.

Figure 53   Mapped Rejoin Example: Staging Channel Schedule (Dead-Roll)
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Event A2 has been allowed to overrun by manually placing it on hold. Events 1- 5 have been 
Dead-Rolled.

At the point of the rejoin in event 3, the following occurs on the Source Channel:

1. The hold is removed from the overrunning PGM event (A2), allowing it to air for the 
duration of the Rejoin Delay and is then followed by the Bumper Event.

2. Events 1 and 2 have already Dead-Aired on the Staging Channel, and are therefore 
disabled on the Source Channel by the system. 

3. Event 3 goes to air at the point that it would have been had there been no overrun, 
and the events that follow play out according to the original scheduled time.

Figure 54   Mapped Mode Rejoin: Overrun on the Source Channel

Staging Channel Source Channel

CFC Interface

Rejoin instruction issued during event 3 Bumper Event Scheduled time is resumed

On-air event plays out for the duration of the Rejoin Delay

Note: This example is based on a Dead-Roll. In the case of a Take Live, no event is required to 
be on hold if rejoining before the end of the inserted live event on the Source Channel.
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4.15 Legacy Join In Progress

When ‘Join In Progress’ is applied to an event, the relevant device appears to be started but 
not cut to air until another event ends. For example, if a live event over runs, it may be better 
to lose part of the next event rather than delay the whole schedule.

Join In Progress allows the next event to start and, when it is eventually cut to air, placed at 
the point it would have been if the live event had not over run.

The device is not started. Instead, the inpoint (refer to page 190) of the material is adjusted 
continually over time and, when the joined event eventually runs, the material starts at the 
calculated inpoint.

The preroll time (refer to page 213) for the device has to elapse.

The schedule has to be in the ‘hold’ state (refer to page 104) for the Join In Progress function 
to be available.

Morpheus prevents the Join In Progress function from joining an event less than 30 seconds 
from the end.

4.15.1 Using Join in Progress

1. From the Tools menu, select Join in Progress.

The Join in Progress dialog box is displayed.

2. Select the relevant event.

3. When the original time of the event has passed, the Rejoin option becomes available. 
Click Rejoin to continue.

Note: The Legacy Join In Progress will be disabled if the Channel Flow Control - Join In Progress 
(CFC-JIP) is configured.

Note: If Join In Progress is activated, its use is recorded in the as-run log (refer to page 93).

Figure 55    The Join In Progress Dialog Box
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4.15.2 Bumper Events

Morpheus can be configured to automatically insert and play out a bumper event prior to 
joining the playlist in progress.

A bumper event is a brief announcement, usually between two and 15 seconds. For example 
“We now rejoin [Film Name]”.

When the operator clicks Rejoin, the bumper event becomes the preset event (the event that 
follows the on-air event).

When the bumper event is taken to air, the new preset event is the event to join in progress.

The start time and SOM (start of material) of the rejoined event are adjusted appropriately.

To change the bumper material:

1. Click on the ellipsis button (...) as shown below:

2. Enter a new material ID as shown in the example below:

The material ID is only accepted if it exists in the Media Management database.

3. Click OK or Cancel as required.

Figure 56    Changing the bumper material ID

Figure 57    Selecting a bumper material ID
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4.15.3 Join In Progress Example

In the following example, the event that follows the live event is in manual take mode (refer to 
page 190). Join In Progress is selected and Use selected event is selected from the Join In 
Progress dialog box. The Rejoin option (under Clear rejoin point) is not yet available.

In the next image, the original end time of the first event to preserve (in the Join In Progress 
dialog box) has passed. The progress bar shows the progress of the on-air event. The Rejoin 
option is now available.

Figure 58    Join In Progress - Rejoin Not Available

Figure 59    Join In Progress - Rejoin Available
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4.16 Timelink Hierarchy

This option allows the operator to set a timelink hierarchy template for the schedule. When 
there are many timelink declarations and references in a large schedule, it is sometimes 
possible to inadvertently create an invalid relationship between the ‘master’ and ‘slave’ 
events. Using a hierarchy template prevents this situation. Refer to the Morpheus Engineer’s 
Manual for information on creating a new template.

To select a template:

1. Click Tools - > Timelink Hierarchy.

2. Select a template from the list. Morpheus then applies the template to the schedule.

The behavior of an event that, according to the template, has an invalid timelink reference 
depends on the ‘Timelink orphaned references’ setting in the System configuration screen in 
the Configurator.

4.17 The AsRun Log

When an event has played, it is greyed out for one minute - the time may vary, depending on 
the configuration of the system.

The event is then removed from the schedule and placed in the ‘AsRun’ database by the 
As Run DB Service (refer to page 214).

Depending on the system configuration, an ‘as run log’ may be created at regular intervals 
and placed in the folder //Morpheus or a configured folder.

The as run log name takes the following format:

<Channel name>_yyyy-mm-dd-nn.sch

Note: The AsRunDbService must be running as a Host Shell service in order for events to be 
removed from the schedule on the Editor

Note: When using a Panoplay system, the Event Journal Collector Service needs to be running 
in order to create as-run logs. Refer to the Morpheus Engineer’s Manual for further 
information.
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4.18 Reviewing Events for Air

This feature ensures that each commercial in a break header is correct within its context 
before being played out. For example, it can be important to prevent commercials containing 
characters from a television programme from being shown during or around the television 
programme itself.

An operator can review and mark a commercial break's location in a schedule as valid in 
advance of going to air. The results of the check appear in the Validation column in the Editor. 
If a commercial is subsequently moved or deleted within a break, the validation status is 
updated.

To configure this feature, refer to the Morpheus Engineer’s Manual.

To review a break and mark it as valid:

1. Right-click on the break header. The following menu is displayed:

Figure 60    Break Validation Menu
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2. Hover the mouse over Break Validation (at the bottom on the menu) to refer to the 
Commercial Break Validation menu as shown below:

3. To approve a break, click Mark All Events in This Break as Valid. The Commercial 
Is Valid icon is displayed in the Validation column. The validation settings for a break 
can be removed by clicking Clear All Validation Tracking for This Break. 

The individual commercials within a break can be marked as valid in the current con-
text by clicking Mark This Event as Valid in This Break. The Commercial Is Valid 
icon is displayed in the Validation column. Clear a commercial's validation settings by 
clicking Clear This Event's Validation Tracking.

Figure 61    Marking a Break as Valid
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4.19 Natural Priority Order

Top-level events in a chain have a natural order priority, meaning that an event higher in the 
chain has priority over an event further down the chain. If a top-level main event has an 
absolute event next (after it in natural order), the absolute event’s start time determines the 
end time of the previous event - unless it causes the previous event’s duration to be zero. In 
this case, the previous event has priority and the absolute event is given a new actual start 
time that is different from the scheduled start time but equal to the previous event’s start time 
plus its duration. In effect, the absolute event’s start time is the value it would have been if it 
was a follow on event.

In addition, when the absolute event is the preset event, because the actual start time of the 
event is different from the scheduled start time, the event becomes a manual event and the 
channel is put into hold, thus requiring some manual intervention to progress the schedule.

When a main event has a fixed start time and is in manual hold, Morpheus treats the event as 
a manual event with a follow-on start time and does not truncate the previous event as shown 
below:

Figure 62    Natural Order Priority
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5. Manual Intervention Panel (MIP)

The ‘Manual Intervention Panel’ (referred to as MIP throughout this section) enables the 
operator to override events on the schedule.

There are several ways in which the MIP window can be opened:

1. From the Window menu, select option 5: MIP.

2. On the toolbar, click on the Show MIP icon.

3. Press F9.

To close the MIP, do one of the following:

• Click on the cross at the top of the MIP window.

• On the toolbar, click Hide MIP.

Resizing the MIP Window

The MIP window can be resized in exactly the same way as any other standard window, and 
in doing so all of the visible buttons are resized proportionally. Additionally, a different sized 
MIP window can be created for each channel.

When the expand button is pressed, the Gang Take channel box is displayed without resizing 
the existing window - all buttons are re-proportioned into the existing window area. Gang Take 
is described in Section 5.2.7.1 Gang Take.

The resizing of the MIP window allows it to be expanded to the full extent of a touch sensitive 
screen, for example.

Figure 63    Manual Intervention Panel
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5.1 MIP Extension

Figure 63 shows the default buttons on the MIP. Additional buttons may appear at the bottom 
of the MIP as shown in Figure 64. These buttons are included in an ‘MIP Extension file’.

Figure 64    MIP Extension
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5.2 MIP Function Buttons

5.2.1 AUTO IS ON

The default mode for Morpheus and indicates that all devices are receiving communication.

In order to disable automation, click AUTO IS ON. The button name changes to AUTO IS 
OFF - this is also displayed on the status bar. The schedule still runs while automation is off, 
but no commands are issued.

To switch automation back on, click AUTO IS ON.

5.2.2 COMP PREV (Compound Preview)

Allows the previewing of a sequence of events, according to the resources available in the 
flexible channel (refer to page 107).

To use compound preview, select the required events and click COMP PREV.

To release the compound preview status from the flexible channel, click on the relevant 
channel icon on the channel bar and click on the RELEASE button on the MIP.

5.2.3 JUNC PREV (Junction Preview)

Allows junctions to be previewed in order to ensure that transitions, for example, will play out 
as intended.

Similarly to COMP PREV (refer to page 99), it allows junctions to be previewed according to 
the resources available in the flexible channel (refer to page 107).

JUNC PREV plays the beginning of one item and the end of the next. The amount of time that 
is played depends on the system configuration.

To use junction preview, select the required events and click JUNC PREV.

To release the junction preview status from the flexible channel, click on the relevant channel 
icon on the channel bar and click on the RELEASE button on the MIP.

5.2.4 SPOT CHECK

Similar functionality to COMP PREV (refer to page 99), except that it removes repetitions of 
material.

SPOT CHECK can be used according to the resources available in the flexible channel (refer 
to page 107).

To use Spot Check, select the required events and click SPOT CHECK.

To release the junction preview status from the flexible channel, click on the relevant channel 
icon on the channel bar and click on the RELEASE button on the MIP.

Note: The Editor may be configured so that automation is always on and cannot be switched off. 
In this case, the AUTO IS ON button is greyed out.
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5.2.5 TAKE GRD PGM (Take Guard Programme)

Click TAKE GRD PGM to activate the guard for the on-air event (refer to ‘Guard Source’ on 
page 33).

All events using the same device as the on-air event are switched to the guard.

In the Source column on the schedule, the guard source is displayed in red text.

5.2.5.1 ‘Dummy’ Guard Source

A feature to provide for continuous playout when media, specified in an event on the 
schedule, is missing or unavailable. In the absence of the specified material on the main 
source, the MaterialID is substituted with an alternative from a ‘dummy’ guard source at a 
point before going to air - validation warnings will be posted in the validation column of the 
Editor to this effect.

This is an automated process that cannot be overridden by an Operator.

5.2.5.2 Toggle Guard

Toggle Guard is available from the right-click menu - it is displayed when right-clicking on a 
highlighted event on the schedule). When selecting Toggle Guard, all events using the same 
device as the highlighted event are switched to the guard source.

Note: To replace the guard device with the main device, click TAKE GUARD PGM again.

Note: If the channel has been configured with a ‘dummy’ Guard Source, then this button is 
disabled. Refer to Section 5.2.5.1

Note: A ‘dummy’ guard source cannot be used as a main or a real guard source. When the 
Dummy Source checkbox is ticked, the following are disabled in order to prevent a Take 
Guard from being performed on the source:

• The Toggle Guard right-click menu option in the Editor

• Take Guard PGM and Take Guard PST buttons on the MIP

When configured with a ‘dummy’ guard source, the main source cannot also have a real 
guard source.

Note: If the channel has been configured with a ‘dummy’ Guard Source, then this option is 
disabled. Refer to Section 5.2.5.1
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5.2.6 TAKE GRD PST (Take Guard Preset)

Click TAKE GRD PST to activate the guard (refer to ‘Guard Source’ on page 33) for the 
preset event (the event that follows the on-air event).

All events using the same device as the preset event are switched to the guard.

In the Source column on the schedule, the guard device is displayed in red text.

5.2.7 TAKE NEXT

Click TAKE NEXT to take the on-air event off air and place the preset event on air (the preset 
event is the event that follows the on-air event).

If the schedule is not running, click TAKE NEXT to start it. If the preset event is not yet cued 
up, the current event is still taken off air, and, while the new event cues up, the output is black.

A TAKE NEXT causes all the times for subsequent follow-on events to be recalculated up to 
the next fixed event (refer to ‘Follow-on and Fixed Events’ on page 117).

If there is a fixed event later in the schedule, there will be an under-run (gap) immediately 
before it.

The ‘as-run log’ reflects the schedule as it is played out (refer to ‘The As-Run Log’ on 
page 93). The shortened duration of one event and the earlier start times of subsequent 
events appear in the log after clicking TAKE NEXT. 

Note: To replace the guard device with the main device, click TAKE GUARD PGM again.

Note: If the channel has been configured with a ‘dummy’ Guard Source, then this button is 
disabled. Refer to Section 5.2.5.1

Note: If the preset event is on the same server port, there will be a slight delay depending on 
what ‘preroll’ has been set for the device.

A video server is sent a 'play' command before the event’s start time to allow for latency. 
This is called the ‘pre-roll’ time.

A VTR is not capable of instantaneous, stable playout. It typically requires a few seconds' 
preroll to guarantee a stable output at the desired inpoint (refer to ‘Inpoint’ on page 185).
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5.2.7.1 Gang Take

An arrow is displayed next to the TAKE NEXT button - it displays (or hides) check boxes for 
each channel and allows a ‘gang take’ to be performed (Figure 65).

In order to be visible in the MIP, channels must have been previously configured to participate 
in a gang take.

A gang take allows the use of TAKE NEXT on a number of channels simultaneously.

Select the channels on which to perform a gang take and click TAKE NEXT.

Figure 65   Gang Take

Note: Depending on the Editor configuration, the Gang Take button can appear next to the Skip 
Next button instead of the Take Next button.
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5.2.7.2 Multisystem Control

The Multisystem Control option allows a take to be performed on channels that are 
processed by more than one EventStore.

1. From the Tools menu on the Editor window, select Multisystem Control.

The Multisystem Gang Take window is displayed.

2. Select the check boxes for each channel to perform a take on.

3. Click Take (to reverse the take, click Undo Take).

The status of the take is displayed in the Executed column.

Figure 66    Multisystem Gang Take Window
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5.2.8 HOLD

Click HOLD to put the on-air event on hold.

‘HOLD’ is displayed in red on the status bar and a pause icon appears in the on-air event’s 
Start Time field.

The event remains on hold until HOLD is clicked again or TAKE NEXT is clicked.

Clicking HOLD causes the start times of all subsequent follow-on events, to be recalculated 
continuously up to the next fixed event (refer to ‘Follow-on and Fixed Events’ on page 117). 
Fixed events may get out of sequence.

HOLD is equivalent to putting the preset event (the event that follows the on-air event) into 
‘manual take’ mode. Refer to ‘Manual Take’ on page 190. The following icon appears in the 
preset event’s Start Time field.

5.2.9 PREVIEW

Select an event in the schedule and then click PREVIEW to preview it on its scheduled 
device.

Note: Hold takes no account of the content or length of the item. This means that unwanted 
content could be broadcast, or, if the item runs out, black or a freeze frame could appear.

Note: PREVIEW requires the device to be free. If it is not, a different device can be selected 
using the event’s Source field in the schedule or the Main Video Source/Main Audio 
Source fields in the Property Inspector (refer to Chapter 3.2.8 Event Field: Source,’ 
Property Inspector’ on page 166 and ‘Main Video Source/Main Audio Source’ on 
page 190).

To cancel preview, click RECUE on the MIP.

Depending on the configuration of the Editor, whilst switching to another channel when 
previewing an item, the following message may be displayed

‘Changing channels whilst previewing will cause the current preview to be re-cued, are 
you sure you want to do this?’.

If Yes is clicked to change to the other channel, the Preview window closes when returning 
to the original channel. Alternatively, the Editor may be configured so that the preview 
window remains open when returning to the original channel and the message is not 
displayed.
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5.2.10 N+1 SYNCH

This button relates to the ‘N+1 resilience mode’ in which a channel is configured to be a 
‘flexible channel’.

Click N+1 SYNCH to transfer the current schedule, including the on-air event with its current 
inpoint (refer to page 185) to the flexible channel.

This then cues up and plays automatically.

5.2.11 SKIP NEXT

Delete the preset event (the event that follows the on-air event) and replace it with the event 
after it. It is important to ensure that there is enough time for the new preset event to cue up.

5.2.12 RELEASE

A function button that is displayed on the MIP for the flexible channel (see below) if any of the 
following have been applied:

• Junction Preview (refer to ‘Junc Prev’ on page 99).

• Compound Preview (refer to ‘Comp Prev’ on page 99).

• Spot Check (refer to ‘Spot Check’ on page 99).

A flexible channel is a 'spare' channel that has its own hardware. It can be used as a backup 
for any other channel. It is a good way of achieving resilience to channel failure. The same 
channel can also be used as a preview channel.

Click RELEASE to clear the items from the flexible channel.

Note: Typical use is when there is a known problem with the preset event, the device playing it, 
or if the schedule is over-running.
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5.2.13 ‘BXF Tertiary’ and ‘BXF N+1’ Synchronisation

Schedule synchronisation mechanisms for the purpose of providing short-term channel 
failover capability. When activated, the schedule is copied from the source channel to a single 
target channel that has been selected by the system from all of those of type ‘Flexible’ that 
are available.

Upon the successful synchronisation of the source channel with the target channel, the 
following message is displayed, the details of which should be noted:

‘PerformNPlusOne for channel <source channel> allocated on
system <target system name> channel <target channel name>’

If the synchronisation is unsuccessful, the following message is displayed:

‘PerformNPlusOne time out for channel <source channel>’

To cancel, click on the button that relates to the active synchronisation method on either the 
source or the target channel - the following message is displayed on the local channel (where 
the channel / system names relate to the local system):

Channel <name> on system <name > released

5.2.13.1 BXF Tertiary

Start channel synchronisation of type ‘BXF Tertiary’. The source channel schedule is copied 
to the target channel; the target channel is updated thereafter with any changes that occur on 
the source channel.

If configured, a descriptive banner may also appear across the source and target channels 
that have been synchronised. - this is specific to the BXF Tertiary synchronisation method.

5.2.13.2 BXF N+1

Start channel synchronisation of type ‘BXF N+1’. A snapshot of the source channel at the start 
time of the synchronisation is copied to a target channel. The Flexible channel is not updated 
with any changes that may occur on the source channel.

Note: Once either synchronisation method is active, the button relating to the other is greyed out, 
thereby preventing it from being triggered.

Note: The syntax of the messages given above is identical regardless of the selected 
synchronisation method.

Note: The schedule on the target system is not removed following a cancellation of the active 
synchronisation method - this remains a manual operation.
Issue 1 Rev. 2 Page 106



Morpheus V4.6 Manual Intervention Panel (MIP)
5.3 Morpheus Access Panel

The Morpheus Access Panel is a hardware panel with buttons configured to provide MIP 
functionality using scripts.

For further information on this option, please contact a Grass Valley representative.

Figure 67   Example Morpheus Access Panel
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6. Event Types and Timings

There are several types of event in Morpheus. These include:

• Primary events (see below).

• Secondary events (see below).

• Header events (refer to page 112).

• Follow-on events (refer to page 121).

• Fixed events (refer to page 122).

6.1 Primary and Secondary Events

A ‘primary event’ (also called a ‘main’ or ‘parent’ event) is a top level event. It may have 
secondary events beneath it or may be a single event on the schedule.

A ‘secondary event’ (also called a ‘child’ event) is associated with a primary event. One or 
more of its parameters are dependent on those of the primary event. It may be a sub event of 
a primary event or a sub event of another secondary event.

Example

A primary event may have secondary events to:

• Start server ports and VTs from the right inpoint (refer to page 185).

• Stop the server ports and VTs

• Make a mixer selection.

Primary Event

Secondary Event

Secondary Event 
of ‘System Default 
- Audio’

Figure 68   Example Primary and Secondary Events
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6.1.1 Displaying/Hiding Secondary Events

If an event has secondary events, a plus sign is displayed in the Link field in that event’s row 
(refer to page 27). Icons may appear in the Secondary Content field (refer to Chapter 3.2.7 
Event Field: Secondary Content), depending on the type of secondary event (refer to 
page 109). The status of the event is also indicated in this field.

• To display a secondary event, click on the plus sign in the Link field in the relevant pri-
mary event row.

• To hide a secondary event, click on the minus sign.

• To hide all secondary content in a schedule, click Collapse All on the toolbar.

• To display all secondary content in a schedule, click Expand All on the toolbar.

6.1.2 Parent / Child Relationships

An event can have several levels. For example, a primary event may have several secondary 
events. The secondary events may have further secondary events below them.

Each level is described below:

• Parent - an event that has one or more lower level events.

• Child - an event that has a higher level event.

• Sibling - an event that is on the same level as another event.

An event can be both a parent and a child. In the following example, Secondary Event 1 is the 
child of PRIMARY EVENT and the parent of Secondary Event 2.

Figure 69   Parent / Child Relationship
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6.2 Secondary Event Types

There are many types of secondary event. Four types are described below.

• DSK event

• DVE event

• GPI event

• Audio over event

6.2.1 DSK Event

A ‘DSK’ (downstream keyer) event controls the superimposition of a video signal, such as a 
logo, over the main programme.

Examples are DSK events are:

• A station logo keyed over a whole programme.

• A station logo keyed over the first 20 seconds of a programme then fading out.

• A ‘coming next’ strap, cutting in one minute from the end of a programme, lasting 15 
seconds and then fading out.

6.2.2 DVE Event

A ‘DVE’ (digital video effects) event controls a DVE move, such as a squeeze, spin, roll, page 
turn or any of the wide range of moves that exist. This would normally be done using the 
optional DVE in the mixer.

The move number is displayed in the Effect No field on the Property Inspector (refer to 
page 166).

Examples of DVE events are:

• Credits squeezed to half width at the end of a programme.

• Spin & condense a final still to a point in the centre of the screen.

6.2.3 GPI Events

‘GPI’ (General Purpose Interface) is a facility, found on some equipment, that enables it to be 
controlled by an external switch. In Morpheus, the control card is the switch, a cable connects 
this to the equipment, and the operation of the switch is a timed event in the Morpheus 
schedule. Usually the function needs the GPI to stay active for as long as the function is 
required. Some equipment has an ‘on’ GPI and an ‘off’ GPI.

Examples of GPI events are:

• Activation of an ARC (Aspect Ratio Converter) if a specific programme needs it.

• Activation of a logo inserter.

• Insertion of cue tones (could be used for downstream switching of, say, a transmitter 
function).
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6.2.4 Audio Over Events

An ‘audio-over’ event is one that plays a sound over the main programme sound. It could be 
live or recorded. It is mixed using the programme audio mixer that also comes under 
automation control, just as the video mixer does. Audio material may be stored on a separate 
server.

An example of an audio-over event is the playing a prerecorded announcement over a 
caption to promote an upcoming programme item.

6.2.5 Adding a Secondary Event to the Schedule

A secondary event can be added to the schedule using The Palette (refer to ‘The Palette’ on 
page 131 and ‘Adding a Secondary Event to the Schedule’ on page 140).

6.2.6 Manual Sub Events

A ‘manual sub event’ is a secondary event that an operator must activate.

To create a manual sub event, right-click on the required secondary event and choose 
Manual Sub Events > Convert to a Manual SubEvent. A small red square is displayed in 
the top left corner of the event’s Main field.

To cue a manual sub event, right-click on the event and choose Manual Sub Events > Cue 
manual subevent (cueing the event makes the device available). A small green arrow is 
displayed in the top left corner of the event’s Main field.

To uncue a manual sub event, choose Manual Sub Events > Un-Cue manual sub event.

To take a manual sub event (operate the manual sub event) choose Manual Sub Events > 
Take Manual sub event.

To stop a manual event playing out, choose Manual Sub Events > End sub event.

To convert the sub event to a normal event, choose Manual Sub Events > Convert to a 
normal sub event.

Note: Manual sub events only work with sub events that are associated with a device. They 
cannot therefore be used in a MediaBall that does not have a device in the MediaBall 
header.
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6.3 Header Events

A ‘header event’ is an event that is used as a label or ‘wrapper’ for other events. The purpose 
of a header event is to group together other events as a single item. There are three types of 
header events:

• Break header

• Opt header

• MediaBall header

6.3.1 Break Header

A ‘break header’ is used as a wrapper for the commercials in an advertising break. A break 
header can be inserted into the schedule, and then add the commercials into it using the 
Palette. Refer to ‘The Palette’ on page 131 and ‘Adding a Break Header to the Schedule’ on 
page 141 for further information.

6.3.1.1 Displaying / Hiding Break Headers

• To show all break headers in a schedule, click Expand All Break Headers on the 
toolbar.

• To hide all break headers in a schedule, click Collapse All Break Headers on the 
toolbar.

Note: The maximum number of main events allowed within a break header is 50 events.
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6.3.1.2 Alternate Breaks

Depending on the system configuration, it can be possible to schedule consecutive 
commercial breaks. One of these breaks becomes disabled automatically.

Using the right-click menu, the other break can be disabled, and it is then possible to toggle 
between that which is enabled and that which is disabled.

If alternate breaks are configured, the Selected Break field is displayed on the 
Property Inspector (refer to page 166).

Figure 70   Alternate Breaks
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6.3.1.3 Displaying Next Break Header

Depending on the system configuration, basic information about the next commercial break 
may be displayed directly above the schedule on a banner, as shown in Figure 71:

The information in the banner includes:

• The date and time when the break is due to play out

• The name of the break header

• The duration of the break

If the banner is displayed, the next commercial break header also automatically expands. It is 
possible to change the color of the panel background.

Depending on the system configuration, it is also possible to lock all commercial breaks in the 
schedule so that they cannot be edited by the operator.

Figure 71    Next Break Banner
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6.3.2 MediaBall Header

A MediaBall® is a single collection of secondary events (refer to section Section 6.1 Primary 
and Secondary Events). A MediaBall that contains frequently used material can be created, 
and then added to a primary event, thus saving time searching for events and adding them 
individually.

As well as grouping together secondary events, MediaBalls can be used to group other event 
types. They can, for example, be useful for channel branding and creating a ‘house style’.

A typical MediaBall may contain the following:

• Coming up strap.

• Credit squeeze to half width.

• Space filled with a graphic.

• Voice over promoting a later programme.

Add a MediaBall header to the schedule using ‘The Palette’ (refer to sections Section 7. The 
Palette and Section 7.7 Adding a MediaBall).

6.3.3 Opt Header

An ‘opt header’ is used to group together events, such as commercials, during an opt-out. For 
example, a service may have several regions with the same programmes but different 
commercial breaks.

For this option to work, opt-out channels must be configured in an opt-out group, with a 
nominated main channel.

When inserting an opt header into a schedule, this header is added to all the other channels 
in the opt-out group - regional commercials can then be added to each channel separately, 
thus ensuring that the commercial breaks are synchronised across all the regions.

Add an opt header to the schedule using the Palette (refer to ‘The Palette’ on page 131 and 
‘Inserting an Opt Header’ on page 143).

Note: Only the commercial breaks are visible in the opt channels, and they take their 
programming from the main channel.
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6.3.4 Fill Regions

The Fill Regions option allows opt headers to be populated in regional channels with 
material from another schedule.

1. From the File menu, choose Fill Regions.

2. Under Regions, select the check boxes for the appropriate channels.

3. Click Pick schedule.

The Fill opt-out Regions window is displayed.

4. Browse to the required drive and folder.

5. Select the schedule containing the breaks to load, and click Open.

6. Click Execute.

A status report is displayed in the centre of the Fill Out-out Regions window to show 
whether the opt headers have been filled successfully.

A report is displayed at the bottom right of the window. If it has a green background, 
the Fill Regions command has been successful.
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6.4 Fixed and Follow-on Events

There are two event start types:

• Fixed

Characterised by a fixed start time, and remains so even if the timing of a previous 
event is changed.

• Follow-on (default)

Starts as soon as the previous event has finished. If an earlier event is deleted or 
inserted, the start time of a follow-on event adjusts accordingly.

They can be applied to a selected event using the Start Type field on the Property Inspector 
(refer to Figure 72 and to Section Section 9. The Property Inspector).

Figure 72   Fixed and Follow-on Events
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6.4.1 Fixed Events

6.4.1.1 Adding a Fixed Event to the Schedule

Add a fixed event to the schedule using the Palette (refer to ‘The Palette’ on page 131 and 
‘Adding a Fixed Event to The Schedule’ on page 138).

6.4.1.2 Fixed Event Considerations

The following situations can arise when using fixed events:

• The fixed event is scheduled to begin before the previous event starts.

• Over Run - occurs when the fixed event is scheduled to begin during the previous 
event. Refer to ‘Over Run’ on page 120

• Under Run - occurs when the previous event is scheduled to end earlier than the 
fixed event’s start time. Refer to ‘Under Run’ on page 120.

If an over run or under run occurs, the event background changes color according to the 
configuration of the Editor.

The Fixed Event is Scheduled to Begin Before the Previous Event Starts

In this instance, as soon as the fixed event becomes the preset event (the event that follows 
the on-air event) it is set to ‘manual take’. It will not run without operator intervention (refer 
to ‘Manual Take’ on page 190).

Note: The start type of the first secondary event is always fixed, even if the parent event is a 
follow-on event (refer to ‘Primary and Secondary Events’ on page 108).

When creating a schedule, it can be useful to put an event into fixed start mode to preserve 
the start times of all the events following it - do so using the Start Type field in the Property 
Inspector (refer to ‘The Property Inspector’ on page 166 and ‘Start Type’ on page 174).

Note: Morpheus does not allow events to be run out of sequence. Events are run in schedule 
order even if an event further down the schedule has an earlier start time that the one 
about to start.

The second timecode shows 
the earliest time that the event 
can start, assuming that all 
preceding events run their full 
duration
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Configuration Settings for Over-Runs and Under-Runs

When an over or under run occurs, a second timecode is displayed in the Duration field 
underneath the event’s duration. This either shows how much material needs to be removed, 
in the case of an over run, or the duration of the under run.

There are several configuration settings for this timecode:

• Show in event previous to fixed event - The two timecodes appear in the Duration 
field for the event before the fixed event.

• Show in fixed event - the two timecodes appear in the Duration field for the fixed 
event.

• Show overrun for event in hold - This applies when the on air event is on hold and 
overruns. When selected, the amount by which the event has overrun is displayed as 
a white timecode above the event’s red countdown progress bar in the Duration col-
umn. When the event has been released from hold the overrun value is no longer rel-
evant and is removed.

• Show scheduled duration - Select this option to display the scheduled duration in 
the event of an event underrunning or overrunning. If this option is clear, Morpheus 
shows the currently adjusted duration. In both cases, the amount of time added or 
subtracted for the event is displayed underneath the event duration.

The images in ‘Over Run’ and ‘Under Run’ on page 120 use the Show in event previous to 
fixed event setting.
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Over-Run

If the fixed event is scheduled to start during the previous event, it truncates or cuts into it. In 
this case, the preceding event does not run for its full duration.

Under-Run

If the previous event is scheduled to end earlier than the fixed start event, one of the following 
occurs:

• If the previous event is a server event, this runs to its end. It remains on a still frame or 
displays black until the fixed event starts.

• If the previous event is a tape event, the tape plays until the fixed event starts. This 
could result in unwanted material being broadcast.

Under-Run and Over-Run Segment Icons

If the last segment in a show is under running or over running, the next event contains a + or - 
icon as appropriate as shown in the example below:

The second timecode shows 
the duration of the overlap, 
indicating how much material 
needs to be removed. The 
minus sign shows that there is 
an over run.

The second timecode shows 
the duration of the under run. 
This helps operators to choose 
appropriate material.

Figure 73    Under-Run and Over-Run Segment Icons
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6.4.2 Follow-on Events

6.4.2.1 Manual Follow-on Event

A follow-on event can be set to start manually by selecting the Manual Take check box (refer 
to page 190) on the Property Inspector.

This means that user intervention is required.

6.4.2.2 Adding a Follow-on Event to the Schedule

Add a follow-on event to the schedule using the Palette (refer to ‘The Palette’ on page 131 
and ‘Adding a Follow-on Event to the Schedule’ on page 137).
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6.5 The Event Ruler

The ‘event ruler’ is displayed between the schedule and the Property Inspector (refer to 
page 166).

It shows the timing relationship between primary and secondary events (refer to page 108).

The functionality and appearance of the event ruler depends on the skin (classic, light or dark) 
that is applied to the Editor.

6.5.1 Classic Event Ruler

The classic event ruler contains yellow and blue bars whose length represents the event’s 
duration and whose position represents the relative timing:

• To show timing details for a primary event and its first level of secondary events, click 
on the primary event. The primary event is shown in yellow and the secondary event 
in blue.

• To show information for a secondary event and its children, click on the secondary 
event. The secondary event is shown in yellow and its children in blue.

A primary event with no children is shown in yellow.

Time in the event ruler flows downwards. The start time is shown at the top of the event ruler 
and the end time at the bottom. The start and end times appear in hh:mm:ss:ff (hours, 
minutes, seconds and frames).

If there is an overlap between two secondary events, the overlapping region is displayed in 
darker blue. 
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Hovering the mouse pointer over a bar in the event ruler displays the event title, start time and 
duration in a pop-up.

If secondary events overlap, it is possible to cycle through the data for the overlapping events 
by right-clicking the overlap cycles.

Figure 74   Event Ruler: Classic Skin

Note: The start and end times of secondary events can be changed using the Offset and 
End Time Offset fields in the Property Inspector (refer to ‘The Property Inspector’ on 
page 166, ‘Offset’ on page 172 and ‘End Time Offset’ on page 191).
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6.5.2 Event Ruler: Light and Dark Skins

This event ruler also contains bars whose length represents an event’s duration but it is more 
configurable and comprehensive than the classic ruler. As well as the main event, it also 
shows the material event as a parallel bar as shown below:

When hovering the mouse over an event, its color changes to yellow and the event details 
appear in a pop-up window. The event details include:

• Event name

• Event kind (for example, BreakHeader)

• Device

• Actual start time

• Actual end time

• Actual duration

Figure 75   Event Ruler: Light and Dark Skins
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6.5.2.1 Event Times

The starting time of the earliest event is displayed at the top of the ruler as shown below:

This can be the starting time of a child event if it begins before the main (parent) event. The 
latest time that an event ends is displayed at the bottom of the ruler. This can also be the end 
time of a child event.The start and end times appear in hh:mm:ss:ff (hours, minutes, 
seconds and frames).

The ruler contains a ‘length of time’ option as shown in Figure 76:

Selecting this option displays vertical units of time allowing the approximate duration of an 
event to be seen at a glance.

Figure 76    Light and Dark Event Ruler Pane

Units of time
for quick 
reference

Tick to view
Time Ruler
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The available units are:

• One hour - displays a vertical bar that represents a timescale of one hour. If an event 
has a running time of less than one hour, the event bar is shorter than the ‘one hour’ 
bar.

• One minute - displays a vertical bar that represents a timescale of one minute. If an 
event has a running time of less than one minute, the event bar is shorter than the 
‘one minute’ bar.

• One second - displays a vertical bar that represents a timescale of one second. If an 
event has a running time of more than one second, the event bar is longer than the 
‘one second’ bar.

• One frame - displays a vertical bar that represents a timescale of one frame. If an 
event has a running time of more than one frame, the event bar is longer than the ‘one 
frame’ bar.
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6.5.2.2 Display options

There are three main display options when using the light and dark skin event ruler.

Show All Events

This option displays the selected event and all other events above and below it in the 
hierarchy (as well as sibling events) as shown in the example below:

Figure 77    Show All Events Option

Parent event

Child event

Selected event

Sibling event

Sibling event

Sibling event

Enable this view
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Show selected event and all its children

This option displays the selected event on the schedule and all of its children as shown below. 

Figure 78    Show Selected Event and All its Children - Example 1

Selected event

Grandchild event

Child event

Child event

Child event

Enable this view
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With this option selected, events above the selected event in the hierarchy and siblings are 
not included as shown in the example below:

Figure 79    Show Selected Event and All its Children - Example 2

Selected event

Child event

Enable this view
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Show Selected Event and its Immediate Children Only

This option displays the selected event and only its immediate children. No parent, sibling or 
grandchild events are displayed.

Figure 80    Show Selected Event and its Immediate Children Only

Selected event

Child event

Child event

Child event

Enable this view
Issue 1 Rev. 2 Page 130



Morpheus V4.6 The Palette
7. The Palette

The ‘Palette’ allows the Morpheus media management database (refer to page 212) to be 
searched for material. When the material has been found, drag and drop it onto the schedule 
as an event.

To open the Palette, do one of the following:

• From the Window menu, choose Palette.

• On the toolbar, click Palette.

• Press F8.

The Palette window is displayed.

An unknown event always appears at the top of the search results area. This is a placeholder 
or default event for modification and has a default duration of 30 seconds.

Figure 81    The Palette - Initial View

Search Criteria Search Results

Sources and Devices
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When a live source is selected, the top line's title changes to LIVE (it remains as UNKNOWN 
for a non-live Source) and its duration becomes that of the selected channel's default main 
event as shown below:

Subsequently, if that item is dropped onto the schedule, its title (either LIVE or UKNOWN) and 
duration are retained. 
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7.1 Palette Configuration

Two right click menus are available from different areas of the Palette window:

• Customise menu

• Search Options menu

7.1.1 Palette Appearance and Behaviour: Using the Customise Menu

Right-click on any pane, except in the Search Criteria area.

- Always on Top / Hide

When moving material between the Palette and Editor, it is practical to display the Palette 
on the top. Ensure the that the Palette is never hidden behind the Editor by clicking on 
Always on Top - in order to revert to normal windows behaviour, click on Hide.

- Set as Default

This parameter only appears in the Customise menu when right clicking in the Sources 
pane.

Figure 82    Palette: Customise Menu
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7.1.1.1 Tabs on the Palette

Depending on the system configuration, several tabs may appear at the top of the Palette 
window. For example:

The Material tab allows material to be searched for, and for primary events to be added to the 
schedule (refer to ‘Searching for Material’ below and ‘Adding a Primary Event to the 
Schedule’ on page 137).

The other tabs allow secondary events to be added to the schedule (refer to ‘Adding a 
Secondary Event to the Schedule’ on page 140).

Figure 83    Tabs on the Palette
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7.1.2 Searching for Material: Using the Search Options Menu

Click on the Options button, or Right click, in the ‘Search Criteria’ pane.

Select the fields with which to perform searches for material against a selected source or 
device - each selected search field is displayed in the Search Criteria pane.

Results are displayed in the Search Results pane, and are limited by default to 1000 rows 
(configurable). The actual number of rows of results found, up to the configured limit, is 
displayed below the Search Results pane. Click on a column heading to sort results in 
ascending or descending order.

Wildcards

• _ (underscore): any single alphanumeric character 

• % (percent): any number of alphanumeric characters

Operation

Click on the Sources or Devices buttons, click on a source / device, then enter a string 
against one or more of the search criteria, and click on the Search button.

Use the Clear button to clear all Search Criteria Fields simultaneously in order to perform a 
different search - the Clear button does not remove the search results.

Figure 84    Palette: Customise Menu
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7.1.2.1 Search Criteria

• Title

Perform a search based upon the title of the material.

• Type

Perform a search against a material type - select one of the following from the 
drop-down menu: 

All: returns a list that includes all material types.

Junction: channel idents and other interstitials

Programme: main programme items.

Commercial: revenue generating advertisements.

LiveRec: material that was recorded live, perhaps using a ‘crash record’ process.

• Duration

Search for material based on a specific duration: enter the required duration in both 
the From and To fields.

Search for material based upon a duration range: enter the shortest duration in the 
From field and the longest duration in the To field.

• Last Aired Date

Search for material based upon the date it was last aired. Click on the arrow next to 
the Recorded Date field then select from the following:

Unknown: the recorded date is not known.

One week: search for material with a recorded date that falls within the last week.

One month: search for material with a recorded date that falls in the last month.

Specify dates: search for material that was recorded within a date range using the 
From an To calendar dates.

• Recorded Date

Search for material based upon the date that it was recorded. Click on the arrow next 
to the Recorded Date field then select from the following:

Unknown: the recorded date is not known.

One week: search for material with a recorded date that falls within the last week.

One month: search for material with a recorded date that falls in the last month.

Specify dates: search for material that was recorded within a date range using the 
From an To calendar dates.

Note: Values can be entered manually or modified using the up and down keyboard keys.
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7.2 Adding a Primary Event to the Schedule

A primary event can be added to the schedule as a follow-on or fixed event (refer to ‘Primary 
and Secondary Events’ on page 108 and ‘Follow -on and Fixed Events’ on page 117).

7.2.1 Adding a Follow-on Event to the Schedule

1. On the Palette, search for the material to be placed on the schedule
(refer to Section 7.1.2 Searching for Material: Using the Search Options Menu).

2. From the devices area, select the required device or source.

3. Drag the event from the Palette onto the schedule.

The item is placed immediately below the event it is dragged to. If the item is to be 
placed at the end of the schedule, drag it to the space below the last event.

Note: If placing commercials on the schedule, it is recommended that only revenue generating 
advertisements are used. When using the ‘Event Summary’ option, the total time of the 
commercials is displayed. This ensures that the schedule keeps to mandatory guidelines 
(refer to ‘Event Summary’ on page 58).

Note: As the event is dragged, the mouse pointer displays the following icons, indicating, 
respectively, a follow-on event, a default event and a sibling event. 

A sibling event is an event that is at the same level as the previous event.
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7.2.2 Adding a Fixed Event to the Schedule

1. On the Palette, search for the material to be placed on the schedule (refer to Section 
7.1.2 Searching for Material: Using the Search Options Menu).

2. From the devices area, select the required device or source.

3. Drag the event from the Palette onto the Start Time column on the schedule (refer to 
‘Start Time’ on page 26).

7.2.3 Right-Click Menu Options

If right-clicking and dragging an event from the Palette onto the schedule, the following menu 
is displayed. Select the required option from the menu.

7.2.4 Material Type Text Colors

The event title on the schedule shows a different color for each material type. Each color is 
shown below:

• Programme - blue

• Commercial - magenta

• Junction - red

• Live - brown

• Live record - brown

Note: If placing commercials on the schedule, it is recommended that only revenue generating 
advertisements are used. When using the ‘Event Summary’ option, the total time of the 
commercials is displayed. This ensures that the schedule keeps to mandatory guidelines. 
Refer to ‘Event Summary’ on page 58.

Note: As the event is dragged, the mouse pointer displays the following icons, indicating, 
respectively, a fixed event, a default event and a sibling event. 

A sibling event is an event that is at the same level as the previous event.

Note: ‘Event Y’ is an existing event in the schedule over which the mouse button has been 
released.

Note: Depending on the configuration of the Editor configuration, the colours on the schedule 
may vary from those shown in this manual.
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7.3 Adding a Default Event to the Schedule

A new default event can be added directly to the schedule from the Editor window as follows:

1. Select the event below which the new event is to be placed, and click on the Add a 
Default Event icon on the Toolbar.

A new event appears on the schedule with the title ‘Manual Addition’.
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7.4 Adding a Secondary Event to the Schedule

Refer to ‘Primary and Secondary Events’ on page 108.

1. On the Palette, click on the relevant tab.

2. Click and drag the required event onto the relevant primary event on the schedule.

3. If necessary, click on the plus symbol in the Link field (refer to page 27) for the event 
to display the secondary event.

4. Edit the event’s fields as required in the Property Inspector (refer to page 166).

5. Use the event ruler (refer to page 122) to ensure that the event will behave as 
expected.

7.4.1 Right-click Options

When right-clicking and dragging a secondary event from the Palette onto the schedule, the 
following menu is displayed. Select the required option from the menu.

7.4.2 Adding the Secondary Event to the Palette for Future Use

In order to use the event in the future, create a ‘MediaBall’ containing that event (refer to 
‘Adding a MediaBall’ on page 144).

Note: The Editor may be configured so that a secondary event can be added by double-clicking. 
Highlight the primary event on the schedule and, on the required Palette tab, double-click 
on the secondary event to be added.
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7.5 Adding a Break Header to the Schedule

For a description of a break header, refer to ‘Break Header’ on page 112.

On the Palette window, drag the Break Header icon (shown below) onto the event on the 
schedule that immediately precedes the break.

The break header is added to the schedule and given the title ‘Break -’.

7.5.1 Changing the Title and Duration Mode of the Break Header

Change the Title

The title of the break header can be changed using the Event Name field on the 
‘Property Inspector’ (refer to page 166).

• In the Event Name field, type the required name for the break header and click OK.

Change the Duration Mode

To ensure that the duration of the break header matches the total duration of the commercials 
within it, select Use Children from the Duration Mode field on the Property Inspector 
(refer to page 166).

Note: A break header is disabled on the schedule until it contains a main event.

Note: The title can also be changed on the schedule. In the Title field, double-click on the title, 
edit the title as required and then press Enter.

Note: This option may not be visible on the Property Inspector. The two most common settings 
are Specified or Use Children.
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7.5.2 Adding Commercials to the Break Header

1. On the Palette, search for the first commercial that is to be placed under the break 
header (refer to Section 7.1.2 Searching for Material: Using the Search Options 
Menu).

2. Hold down the right mouse button and drag the commercial from the schedule on to 
the break header.

3. Release the mouse button to display the following menu:

4. Select Create fixed event as a child of System Default - Break Header.

5. Continue to add further commercials in this way.

Note: It is recommended that only revenue generating advertisements are used. When using the 
‘Event Summary’ option, the total time of the commercials is displayed. This ensures that 
the schedule keeps to mandatory guidelines (refer to ‘Event Summary’ on page 58).
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7.6 Inserting an Opt Header

(For a description of an opt header, refer to page 112).

7.6.1 Adding an Opt Header to the Schedule

• On the Palette, drag the Opt icon onto the event on the schedule below which to insert 
the opt header.

The opt header is added to the schedule and given the title ‘New Opt Header’ - it also 
appears on the opt-out channel.

7.6.2 Adding Events to the Opt Header

1. On the Palette, search for the first event to be placed under the break header (refer to 
Section 7.1.2 Searching for Material: Using the Search Options Menu).

2. Hold down the right mouse button and drag the event from the schedule on to the 
break header.

3. Release the mouse button to display the following menu:

4. Select Create fixed event as a child of New Opt Header.

7.6.3 Duration Mismatch

If the opt breaks in the opt-out channels differ, large + and – signs appear against the 
durations of the break headers to indicate this.

Note: An opt header has no use in a single channel system, or in a multi channel system where 
the channels are independent.

Note: If adding commercials, it is recommended that only revenue generating advertisements are 
used. When using the ‘Event Summary’ option, the total time of the commercials is 
displayed. This ensures that the schedule keeps to mandatory guidelines (refer to ‘Event 
Summary’ on page 58).

Note: Depending on the system configuration, validation icons can appear in the Validation 
column on the schedule if the duration of the opt breaks differs (refer to ‘Validation’ on 
page 38).
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7.7 Adding a MediaBall

For a description of a MediaBall, refer to ‘MediaBall Header’ on page 117.

7.7.1 Creating a MediaBall

1. On the Palette, click on the MediaBall tab (or another tab if required).

2. On the schedule, highlight the secondary event(s) to be included in the MediaBall 
(refer to page 43).

3. Point to any of the highlighted events.

4. Hold down the right mouse button and drag the events to a blank area on the Media-
Ball tab (or other tab).

The MediaBall™ Editor window is displayed.

5. In the Name field, type a name for the MediaBall.

6. From the Icon section, click on the required icon.

Note:  MediaBalls can only be created if the used role permits it.

Figure 85    The MediaBall Editor Window
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7. Select the required Default Duration Mode:

• Independent - indicates that the duration of the MediaBall is specified inde-
pendently rather than being inherited from the parent event.

• Use Owner - sets the duration of the MediaBall event to be equal to that of its 
parent.

• Use children - sets the duration of the parent event to the total duration the child 
MediaBall events.

• End with parent - sets the MediaBall to end at the same time as the parent event 
(refer to Primary and Secondary Events on page 108).

• Relative to owner - allows two offsets to be set, one from the start and one from 
the end of the parent event.

8. Click OK.

The new MediaBall is displayed on the tab.

7.7.2 Adding a MediaBall to the Schedule

1. On the Palette, click on the MediaBall tab.

2. Drag the required MediaBall onto the required primary event on the schedule (refer to 
‘Primary and Secondary Events’ on page 108).

3. If necessary, click on the plus symbol in the Link field (refer to page 27) for the event 
to expand the Mediaball and ensure it contains the expected items.

The MediaBall header should have the same start time (refer to page 26) and duration 
(refer to Chapter 3.2.6 Event Field: Duration) as the parent event.

4. Use the event ruler (refer to page 122) to ensure the MediaBall will behave as 
expected.

Note: For information on event relationships, refer to Primary and Secondary Events on 
page 108).
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7.8 The Hotlist

The ‘hotlist’ is a list of frequently used material - build a hotlist for future use by adding items 
from the schedule.

7.8.1 Displaying the Hotlist

• On the Palette, click on the Material tab.

The search results area is displayed in ‘database query’ view.

• To switch to ‘hotlist’ view and display the hotlist, click on the Show Hotlist button:

7.8.2 Adding Material to the Hotlist

1. On the schedule, highlight the events to be added to the hotlist (refer to page 43).

2. Point to one of the highlighted items.

3. Hold down the right mouse button and drag the items onto the hotlist.

7.8.3 Moving Material From the Hotlist to the Schedule

7.8.3.1 Adding the Material as a Follow-on Event

‘Follow-on Events’ are covered on page 121.

1. On the hotlist, point to the event to be moved to the schedule.

2. Drag the event from the hotlist onto the required position on the schedule.

7.8.3.2 Adding the Material as a Fixed Event

‘Fixed Events’ are covered on page 122.

• On the hotlist, point to the event to be moved to the schedule.

• Drag the event from the hotlist onto the Start Time column on the schedule (refer to 
page 26).

Note: Whilst dragging, the mouse pointer displays the following icons, indicating, respectively, a 
follow-on event, a default event and a sibling event. A sibling event is an event that is at the 
same level as the previous event.

Note: Whilst dragging, the mouse pointer displays the following icons, indicating, respectively, a 
fixed event, a default event and a sibling event. A sibling event is an event that is at the 
same level as the previous event.
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7.8.4 Deleting an Item from the Hotlist

1. Click on the item to be deleted.

2. On the keyboard, press Delete.

7.8.5 Clearing the Hotlist

• To clear all items from the hotlist, click Clear Hotlist.

7.8.6 Returning to Database Query View

• To return to database query view from the hotlist, click:

Note: The UNKNOWN event remains.
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7.9 Thumbnails

If a Material ID in the Palette is a valid Material ID in a connected Momentum system and a 
thumbnail image exists, it appears in the Palette as shown below:

If the Material ID in the Palette is a valid Material ID in the Momentum system but it does not 
have a thumbnail image, the default icon is displayed:

If the Material ID in the Palette does not exist in the Momentum system, no thumbnail image 
or icon is displayed.

Figure 86    The MediaBall Editor Dialog Box
Issue 1 Rev. 2 Page 148



Morpheus V4.6 The Commercial Hotlist
8. The Commercial Hotlist

The Commercial Hotlist provides a way of manipulating content in a channel’s playlist quickly, 
usually during a live event. Using the Commercial Hotlist, a change can be made to a break in 
one channel that will ripple through to linked breaks in other channels. This means that it is 
not necessary to make changes individually across channels.

Using the Commercial Hotlist, it is possible to perform the following actions:

• Add or delete material across channels from future breaks or from the on air break.

• Return immediately from a break to the live programme, regardless of the point in the 
material.

• Return from a break to a live programme but allow the playing material to finish.

• Replace a break on the schedule with another on the Commercial Hotlist.

• Move a break to the preset position on the schedule.

• Add a break across all channels.

• Add material to any selected unplayed break on a single channel or multiple channels.

• Remove material from an unplayed break.

• Divide a break at a specific time.

• Add breaks and schedules to the Commercial Hotlist that can later be added across 
channels.

• Load and edit schedules generated by the BXF Schedule service.
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8.1 Displaying the Commercial Hotlist

From the Tools menu, choose Commercial Hotlist.

8.2 Timelinking

In order for the changes to ripple through to other channels, the breaks use the Time Link 
Declaration and Time Link Reference fields on the Property Inspector. For more 
information, refer to ‘Time Link Declaration/Time Link Reference’ on page 187.

Figure 87   Morpheus Editor Tools Menu

Master Channel

Linked Channels
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8.3 The Commercial Hotlist Window

This section contains information on the Commercial Hotlist Window.

8.3.1 Hotlist Timeplane

Provided that the Commercial Hotlist is configured to show the Hotlist Timeplane, it is 
displayed in the top section of the window. When a break is selected in the Hotlist (see 
below), its contents appear in the Hotlist Timeplane. For detailed information about the Hotlist 
Timeplane, refer to Section 8.7 Online Mode.

8.3.2 Hotlist

The ‘Hotlist’ is displayed in the bottom section of the window. It shows breaks from merged 
schedules. For detailed information about the Hotlist, refer to Section 8.8 Offline Mode.

Channel BarHotlist Timeplane

Hotlist

Figure 88   The Commercial Hotlist Window

Commercial 
Hotlist Modes

Commercial Hotlist Buttons

Note: The displayed channel name is dependent upon the configuration of the Commercial 
Hotlist.
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8.3.3 Channel Bar

A channel bar is displayed to the left of the Hotlist Timeplane. This shows each available 
channel.

8.3.4 Commercial Hotlist Modes

One of three modes can be selected when working with the Commercial Hotlist - the mode 
that is selected determines the options that are available. There three modes are:

• Online - refer to Section 8.7 Online Mode

• Offline - refer to Section 8.8 Offline Mode

• On Air Edit - refer to Section 8.9 On Air Edit Mode

8.3.5 Commercial Hotlist Buttons

According to the configuration, the following buttons may be available at the bottom of the 
Commercial Hotlist window:

• Kill - refer to page 163

• Abort - refer to page 163

• Replace - refer to page 164

• Cue to Air - refer to page 164

• Cue to PST - refer to page 164

8.4 Loading a Schedule into the Commercial Hotlist

1. From the Commercial Hotlist File menu, select Load Breaks from Schedule.

The Open dialog box is displayed.

2. Browse to the drive and folder containing the required schedule.

3. Select the schedule and click Open.

The breaks are loaded into the Hotlist at the bottom section of the window.

8.5 Clearing the Commercial Hotlist

1. From the File menu, choose Clear Hotlist.

2. To confirm, click Yes.

Note: As with the Editor window, barrels appear in the Status column to indicate the status of the 
breaks on the playout device (refer to ‘Status Barrels’ on page 34).
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8.6 Search and Replace on the Commercial Hotlist

Events can be searched for on the Commercial Hotlist by Material ID, and the Material IDs 
can be changed using the Replace feature. 

To use this feature, click Edit -> Replace on the menu toolbar. The following dialog box is 
displayed:

8.6.1 Hotlist Scope

The search and replace feature can be used on a single event or on the entire hotlist by 
selecting an option in the Hotlist Scope section.

• Event - The search and replace feature applies only to the currently selected event in 
the Commercial Hotlist. The event name appears next to the Event option as shown 
below:

• Hotlist - The search and replace feature applies to every event currently in the Com-
mercial Hotlist.

Figure 89   Opt Header Links
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8.6.2 Searching for Material

To search for material, enter the Material ID of the item into the Material ID text box.

Clicking Search Next highlights the next item in the hotlist that matches the Material ID.

Clicking Search Prev highlights the previous instance of the item in the hotlist.

Clicking Search All displays a pop-up window containing the number of instances of the 
material that have been found in the hotlist as shown in the example below:

8.6.3 Replacing Material IDs

To replace the Material ID of an event:

1. Click on the event in the Commercial Hotlist.

2. Enter the Material ID that to be replaced in the Material ID text box.

3. Enter the Material ID that will replace it in the Replace With text box. 

4. Click Replace to change the event Material ID. Click Replace All to change the Mate-
rial IDs of all matching events.
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8.7 Online Mode

Online mode links the Editor schedule and Hotlist Timeplane. In this mode, any change made 
to a break on the Hotlist Timeplane (refer to page 151) affects breaks across linked channels. 
For example, if material is removed from a break, that material is also deleted from breaks in 
selected linked channels.

To work in online mode, select the Online option button in the Mode section.

When selecting a break on the Editor schedule, the corresponding break is displayed on the 
Hotlist Timeplane. All timelinked channels and their material appear for that break.

In Online mode, the following actions can be performed:

• Add material to a break - refer to ‘Adding Material to a Break’ below

• Delete material from a break - refer to ‘Deleting Material from a Break’ on page 156

• Use ‘Split’ to divide a break at a specific time - refer to ‘Using Split’ on page 158

8.7.1 Adding Material to a Break

In Online mode, material can be added to any selected unplayed break. The material can be 
added to:

• All linked channels.

• A channel and its respective linked channels.

• Individual channels.
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To add material to a break:

1. On the Editor schedule, select the break to edit.

The Hotlist Timeplane shows all material for the selected break across all timelinked 
channels.

2. On the Hotlist Timeplane, do one of the following:

• To select all linked channels, double-click on the master channel on the channel 
bar.

• To select a channel and its linked channels, double-click that channel on the 
channel bar. For example:

• To select individual channels, hold down the Ctrl key and, on the channel bar, 
click on the required channels. For example:

3. Open the Palette (refer to page 131).

4. On the Palette Devices or Source tab, select a source.

5. Search for the required material (refer to Section 7.1.2 Searching for Material: Using 
the Search Options Menu).

6. Drag the material from the Palette to the Hotlist Timeplane.

A TV icon and a vertical line are displayed. The vertical line can be green or red:

• Green indicates that the material will play across all channels simultaneously.

• Red indicates that the material will not play simultaneously across all channels.

7. Drag the vertical line to the required position on the Hotlist Timeplane and release the 
mouse button.

The material drops onto all selected channels. It is added to the Editor automatically 
and the appropriate server is selected.

Note: If the drop is made with a red vertical line, the material is placed after the material it was 
dropped onto.

Double-click a 
channel to select 
all its linked 
channels

Hold down the Ctrl 
key and click on 
the required 
channels
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8.7.2 Deleting Material From a Break

In Online mode, material can be deleted from any unplayed break.

1. On the Editor schedule, select the break to edit.

The Hotlist Timeplane shows all material for the selected break across all timelinked 
channels.

Hover the mouse over material on the Hotlist Timeplane in order to display the title, 
material ID and duration of the material.

2. Select the material to remove:

• To select individual pieces of material, hold down the Ctrl key and click on the 
material.

• To select all material with a specific material ID, double-click one piece of material 
with that ID.

3. Click on Delete.

A confirmation message is displayed to show the number of commercials that will be 
deleted. It also shows that by deleting them the break duration will either be the same 
across channels or will not match. If a channel has been omitted, it may be necessary 
to add time in order to ensure that each channel has the correct break duration.

4. To confirm and delete all selected material, click Yes.

8.7.2.1 Deleting Material from an On Air Break

In order to delete material from a break that is on air, refer to ‘Deleting Material from a Break’ 
above. However, the On Air Edit mode option button must be selected first. Refer to Section 
8.9 On Air Edit Mode for further information.
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8.7.3 Using ‘Split’

The Split button activates a green vertical line on the Hotlist Timeplane. This can be used to 
divide a break at a specific time.

1. In Online mode, select the required break on the Hotlist Timeplane and then click 
Split.

2. Point to the green vertical line to the right of the channel bar.

3. Click and drag the line to the required position on the break. Its color is either red or 
green:

Green indicates a uniform outpoint across the break in all channels. This means that 
the break can be divided in two at the point selected.

Red indicates that the outpoint is not uniform across all channels. This means that on 
some channels, material may play longer than on others before joining the pro-
gramme again. The Split option does not allow material to be cut short.

4. Click Split and click Yes to confirm.

The break duration changes according to the split point.

8.7.4 Viewing Commercials of the Same Duration

The following buttons allow commercials of equal duration to be viewed in the 
Hotlist Timeplane. For example, click 10 to show all 10 second commercials.

Note: An event’s outpoint determines at what timepoint, in the tape item or server file, the device 
stops playing. This would usually be 00:00:00:00 (hours, minutes, seconds, frames) for a 
server event or 10:00:00:00 for a tape event (depending on the station’s method of 
working).
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8.8 Offline Mode

Offline mode refers to the Hotlist at the bottom of the window. When clicking on a break 
header on the Hotlist, all timelinked channels appear in the Hotlist Timeplane.

To work in Offline mode, select the Offline option button in the Mode section.

The Hotlist can be expanded to show material for each linked channel.

In Offline mode, breaks and material can be added, edited and deleted using the right-click 
menu.

Any changes made in the hotlist are not reflected on the Editor schedule. 

In order to add a break to the Editor schedule that was created or edited in the 
Commercial Hotlist, do so using Replace (refer to page 164) or Cue to PST (refer to 
page 164).

8.8.1 Inserting Breaks

It is possible to insert an existing break from the schedule or insert a new break directly into 
the hotlist.

8.8.1.1 Inserting a New Break into the Hotlist

1. Right-click anywhere on the Hotlist and then choose Insert Break.

A new line is displayed on the Hotlist.

2. Type the name of the break and press Enter.

8.8.1.2 Adding a Break from the Schedule to the Commercial Hotlist

1. Point to the required break on the schedule.

2. Right-click and drag the break onto the Hotlist.
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8.8.2 Inserting Commercials

It is possible to insert a commercial directly into the hotlist, from the Editor Palette or from the 
hotlist into the schedule.

8.8.2.1 Inserting a Commercial from the Commercial Hotlist Interface

1. On the Hotlist, right-click on the break under which to insert the commercial.

2. From the right-click menu, choose Insert Commercial.

The commercial appears below the break.

3. Enter the material ID of the break and press Enter.

8.8.2.2 Inserting a Commercial from the Palette

1. Open the Palette (refer to page 131).

2. Search for the commercial to insert (refer to Section 7.1.2 Searching for Material: 
Using the Search Options Menu).

3. Drag the material from the Palette onto the required break in the Hotlist.

8.8.2.3 Inserting a Commercial from the Commercial Hotlist

• Right-click and drag the required commercial from the Hotlist to the required position 
on the schedule.

Note: By default, the commercial will adopt the Main Video Source defined in the configuration of 
the Commercial Hotlist. Double click in the Source Column of the commercial in order to 
display a drop down menu - change the source as required.
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8.8.3 Editing Breaks and Commercials

It is possible to edit a break or just a commercial.

8.8.3.1 Editing a Break

1. Right-click on the break to edit and choose Edit Break.

The cursor appears in the Material Id field.

2. Enter the required ID and press Enter.

8.8.3.2 Editing a Commercial

1. Right-click on the commercial to edit and choose Edit Commercial.

2. Change the MaterialId as required and press Enter.

3. By default, the commercial will adopt the Main Video Source defined in the configura-
tion of the Commercial Hotlist. Double click in the Source Column of the commercial 
in order to display a drop down menu - change the source as required.

8.8.4 Deleting Breaks and Commercials

It is possible to delete a break or just a commercial.

8.8.4.1 Deleting a Break

1. Select the break to delete.

2. Right-click on the break and choose Delete Break.

8.8.4.2 Deleting a Commercial

1. Select the commercial to delete.

2. Right-click on the commercial and choose Delete Commercial.

Note: The material ID can also be edited by double-clicking the Material ID field.

Note: The material ID can also be edited by double-clicking the Material ID field.

Note: The break can also be deleted by pressing Delete on the keyboard.

Note: The break can also be deleted by pressing Delete on the keyboard.
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8.9 On Air Edit Mode

This option is only available when a break is 'on air' and references a break on another 
channel using time linking. The On Air Edit mode can also be used in order to make a change 
to a break that is currently airing.

When a break has gone to air, select the On Air Edit option button in the Mode section:

The Hotlist Timeplane displays the content for all channels for the selected (on-air) break. It 
also shows a green progression bar as the break plays out as shown below:

In this mode, content can be added or removed in an on air break.
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8.10 Commercial Hotlist Buttons

The Commercial Hotlist buttons appear at the bottom of the Commercial Hotlist window. Each 
is described below.

8.10.1 Kill

Use the Kill button when it is necessary to return from a break to the live source, regardless 
of the point of the material in the break. Kill interrupts all playing content.

1. With the Commercial Hotlist in On Air Edit mode (refer to page 162), select the on air 
break on the schedule. 

The Hotlist Timeplane shows the remaining material in the break.

2. Click Kill.

8.10.2 Abort

Use the Abort button when it is necessary to return from a break to the live source. Unlike 
Kill, Abort retains the immediate on air material and plays it until completion.

1. With the Commercial Hotlist in On Air Edit mode, select the on air break on the sched-
ule.

The Hotlist Timeplane shows the remaining material in the break.

2. Click Abort.

8.10.3 Replace

The Replace button allows a break on the Editor schedule to be replaced with a break on the 
Hotlist.

1. With the Commercial Hotlist in Offline mode, select the break to replace on the Editor 
schedule.

2. On the Hotlist, select the break to replace it with, and click Replace.
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8.10.4 Cue to Air

Cue to Air allows a break to be preset with a fixed start time (the preroll period) very shortly in 
the future, so that the break starts a few seconds after pressing the button. This effectively 
cues the break to air.

1. On the schedule, select the on air event.

2. In the Hotlist, select the break that to cue.

3. Click Cue to Air.

The break is deployed automatically across any linked channels.

8.10.5 Cue to PST

Cue to PST allows a break to be moved to the preset position on the schedule.

1. On the schedule, select the on air event.

2. In the Hotlist, select the break that to move to the preset position to air.

3. Click Cue to PST.

The break is deployed automatically across any linked channels.

8.11 Transfer Requests

The Commercial Hotlist can be configured to make automatic transfer requests for material 
that is in the hotlist but is not present on the required devices.

To enable this feature:

1. Click Edit - > Configuration.

2. Click on the Database tab.

3. Select the Enable Transfer Requests option.

4. Click OK.

Note: Each of these functions only appears as a button on the main Commercial Hotlist window if 
it is enabled in the Commercial Hotlist configuration.
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8.12 Locking Hotlist Material

The Commercial Hotlist feature can be configured to lock all material that is currently in the 
hotlist. This material cannot be transferred or deleted from the current device until it is 
removed from the hotlist.

To enable this feature:

1. Click Edit -> Configuration.

2. Click on the Database tab.

3. Select the Enable Material Locking option.

4. Enter a name to identify the material in the hotlist.

5. Click OK.
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9. The Property Inspector

The ‘Property Inspector’ is displayed on the right-hand side of the Editor window. It displays 
properties for the event highlighted on the schedule for example, ‘Start Type’ or ‘Duration’.

The parameters that appear on the Property Inspector, the order in which they appear and the 
properties that can be modified, are applied in the Configurator - it is not normally accessible 
to operators.

The Property Inspector is divided into parts corresponding to different components of the 
scheduled event. The parts are separated by a grey bar containing a repeat of the event 
name. In the following example, the upper part displays properties for the mixer (or main) 
event, and the lower part shows properties for the playout event.

Properties of the mixer device Properties of the playout device

Figure 90    The Property Inspector
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9.1 Changing Properties

Depending on the system configuration, it may, or may not be, possible to modify the 
properties for a selected event on the schedule (for information on some of the properties, 
refer to ‘Primary Event Fields on the Property Inspector’ on page 174 and ‘Secondary Event 
Fields on the Property Inspector’ page 191).

• To change a property, enter the text in the appropriate field or click on the arrow on the 
field and select an item from the list.

• To change a timecode, either type the required digits in the field or use the up and 
down arrow keys to increase or decrease the digits.

9.2 Accepting/Rejecting Changes

When making changes to properties, a blue bar is displayed to the left of each field:

• To accept the change(s), click OK or press Enter.

• To abandon the change(s), click on the blue bar(s), or click Cancel.

• If the blue bar remains after clicking OK, this shows that the change has not been 
accepted. Ensure that the value entered is valid for that property.

• If a changed property reverts to its original value, this could be because a system 
option called ‘Decorate Always’ has been set using the ‘Material Decorator’. This pre-
vents the property from being changed. Refer to ‘The Material Decorator’ below.
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9.3 Property Aliases

Some property names on the Property Inspector can be different from their actual property 
names in the Morpheus system. These aliases are configurable in the Morpheus Configurator 
application.

9.4 The Material Decorator

Some properties on the Property Inspector are ‘decorated’ (populated) by the Morpheus media 
management database (refer to page 212) using an application called the ‘Material Decorator’. 
Depending on the system configuration, these properties can include:

• Duration

• In Point

• Material Type

• Title

• Notes

• QC

The Material Decorator has two settings:

• Decorate Always

• Decorate Once Only

9.4.1 Decorate Always

The normal system setting (‘Decorate Always) prevents the values for any of the above 
properties from being changed. If a value on the Property Inspector is modified, once OK is 
clicked the property reverts to its original value.

9.4.1.1 Overriding the Decorate Always Setting

Change a value for a property that is being constantly ‘decorated’ as follows:

• In the event’s Multipart Programme Id field, type an identifier and click OK (refer to 
‘Multipart Programme Id’ on page 190).
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9.4.2 Decorate Once Only

The ‘Decorate Once Only’ system setting overrides the ‘Decorate Always’ setting and allows 
the value in the above properties to be changed once the initial decoration has occurred 
(usually when a schedule is loaded).

9.4.2.1 Overriding the Decorate Once Only Setting

After changing a value, it can be returned to its original value in either of the following ways:

• Click Query. Refer to ‘The Query Button’ on the following page.

• Right-click on the event and click Force Decorate Events. The Force Decorate 
Events option may not be enabled on the system.
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9.5 The Query Button

The Query button has two functions:

• Populates blank fields on a scheduled event.

• Resets a field, that is set to ‘Decorate Once Only’.

9.5.1 Populating Blank Event Fields

Use the Query button to populate the following fields on a scheduled event, based on the 
material ID:

• Title

• Duration

• File ID

The fields that are populated depend on the system configuration.

To populate the fields:

1. In the Material Id field, type the material ID.

2. Click Query.

Some or all of the fields listed above are populated. A blue bar is displayed to the left 
of each relevant field.

3. To replace the fields on the schedule, click OK (to abandon the changes, click Can-
cel).
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9.6 Filtering Fields

The Filter property allows a filter to be applied to the fields that appear on the 
Property Inspector - for example, the filter can be configured to only display fields that start 
with a particular letter or that contain a specific word. 

In the example below, only fields with the word ‘Material’ are displayed.
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9.7 Mixer Device Properties

Fields on the mixer device section of the Property Inspector.

9.7.1 Offset

An ‘offset’ is the time difference between the start/end of the primary event and the start of the 
secondary event.

The offset can be positive or negative:

• A secondary event with a positive offset begins after the start/end of the primary 
event.

• A secondary event with a negative offset begins before the start/end of the primary 
event.

The Offset field links to the Start Mode field (refer to ‘Start Mode’ below).

The possible settings for the Offset field are shown in the following table:

Start Mode
Positive/Negative 
Offset

Result

Reference to 
parent’s beginning

Positive The secondary event begins after the start of 
the primary event.

Negative The secondary event begins before the start of 
primary event.

Reference to 
parent’s end

Positive The secondary event begins after the end of 
the primary event.

Negative The secondary event begins before the end of 
primary event.

Table 9   Offset Settings
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9.7.1.1 Changing the Offset

In the Offset field for the secondary event, enter the offset in hh:mm:ss:ff 
(hours:minutes:seconds:frames). To set a negative offset, enter a minus sign at the beginning 
of the Offset field.

9.7.2 Start Mode

Specify whether a secondary event starts at the end or beginning of the parent event. Each 
option is described below.

9.7.2.1 Reference to Parent’s Beginning

Start the secondary event at the same time as its parent, taking into account any offset (refer 
to ‘Offset’ below).

9.7.2.2 Reference to Parent’s End

Start the secondary event at the end of the parent event, taking into account any offset (refer 
to ‘Offset’ below).

Note: The offset can also be changed using the Offset field on the schedule (refer to Chapter 
3.2.4 Event Field: Offset).

To view the effect of the offset, use the event ruler (refer to page 122).

Important: A note on terminology.

The term ‘Parent’ and ‘Owner’ are entirely interchangeable, except when referring to the 
Start Mode of a Follow On event, and at any level deeper than the top level, as follows:

• An event Start Type of ‘Fixed’ establishes a new datum for the start time, therefore 
the Start Modes ReferenceToParentsBeginning and ReferenceToParentsEnd 
define ‘Parent’ as referring to the owner event.

• With an event start type of ‘Follow On’, the Start Modes ReferenceToParentsBegin-
ning and ReferenceToParentsEnd define ‘Parent’ as referring to the previous sib-
ling event.

•
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9.7.3 Start Type

The Start Type of an event can either be Follow-On or Fixed (refer to ‘Follow-on and Fixed 
Events’ on page 117). To change the start type, select the required type from the list.

When Fixed is selected from the Start Type list, the Start Time and Start Date fields appear 
above it. In the Start Time field, enter the start time in hours, minutes, seconds and frames. 
From the Start Date field, select the required start date.

9.7.4 Main Video Source

This field shows the main video source for the event and can be changed if the system 
configuration allows it.

9.7.5 Duration

This links to the Duration field on the schedule (refer to Chapter 3.2.6 Event Field: Duration) 
and shows how long an event lasts in hours, minutes, seconds and frames.

Use this field to change the duration, if the system configuration allows it. Use caution when 
increasing the duration - it is likely to result in playing out black. Decreasing the duration 
truncates the item.

9.7.5.1 Changing the Duration of the On-Air Event

It is not possible to change the duration of the on-air event using the Duration field on the 
Property Inspector. The duration can however be changed as follows:

1. Right-click on the on-air event and choose Edit Duration.

2. The Programme event editor dialog box is displayed, showing the current channel 
and on-air event title.

Figure 91    Programme Event Editor Dialog Box
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3. Do one of the following:

• To change the duration of the event, select Edit duration (under Set duration). 
Enter the required duration in the New duration field.

• To change the event’s end time, select Edit end time (under Set end time). If 
required, enter a new date in the field provided or click on the arrow on the date 
field and select the date from the calendar. In the time field, enter the required 
end time.

4. Click OK.

9.7.6 Main Audio Source

This field shows the main audio source for the event and can be changed if the system 
configuration allows it.

9.7.7 Transition Duration

A transition is a mixer function that allows different ways of passing from one event to the 
next, the simplest being a 'cut'. Others include fades, mixes and wipes. More advanced types 
include DVE transitions.

This field shows how long the transition lasts in hours, minutes, seconds and frames.

Use this field to change the transition duration.

9.7.8 Is Guard Event

If a guard source (refer to page 33) is set up for an event, the material event relating to it is 
shown at the bottom of the Property Inspector with this check box selected.

Note: If the new duration is shorter than the time that has already played out, or if the new end 
time is in the past, an error message is displayed.
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9.7.9 Transition Type

The range of transitions available from the Morpheus Editor depends on the vision mixer that 
is incorporated in the system. If no mixer is present then only cuts are possible. If a mixer is 
present but only one server port is available, then any transition that does not involve 
overlapping of material can be performed, namely cut, V-fade, U-fade, fade and take, take 
and fade. However to perform a cross fade (also known as X-fade, mix or dissolve) or any 
kind of wipe, two server ports and a mixer are needed. The Mix field on the schedule displays 
an icon that represents the mixer transition for the start of the event. The default transition is 
‘Cut’.

If the system configuration allows it, the Transition Type drop-down list can be used in order 
to change the mixer transition.

Note: The transition can also be changed using the Mix field on the schedule (refer to Chapter 
3.2.5 Event Field: Mix).

When two back-to-back main events are scheduled to play out on the same source, and 
they are configured for anything other than a transition of type ‘cut’, then the following will 
occur:

• The event that is that is due to transition out is truncated at the start of the 
transition, thereby producing the effect of a cut

• The event that is transitioning in will do so at the programmed time and according 
to the configured transition type
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9.7.9.1 Transition Editor

Depending on the Editor configuration, the following may appear next to the Transition Type 
field:

• Clicking this displays the Transition Editor dialog box.

• Allows transitions to be set up visually. The figures that appear in the fields in the 
Transition Editor are transferred automatically to the Property Inspector.

• The audio transition tracks the video as long as the Track Video check box is 
selected. The Synchronise With Video button does the same thing but it can be 
changed again afterwards. The maximum duration of any transition is 99 frames in 
both 625/50 and 525/60 systems.

• Only a small number of mixers support this function.

Figure 92    Transition Editor Dialog Box
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9.7.10 Manual Take

When the Manual Take check box is selected on the Property Inspector, the following icon is 
displayed in the Start Time field on the schedule and the start time is underlined.

The event does not run until one of the following actions is performed:

• Click Take Next on the Manual Intervention Panel (refer to ‘Manual Intervention 
Panel’ on page 97 and ‘Take Next’ on page 101).

• Clear the Manual Take check box.

In manual take mode, the event Start Time updates once per second until one of the actions 
above is performed. The start times of subsequent follow-on events update in the same way 
up to the next fixed event (refer to ‘Follow-on and Fixed Events’ on page 117).

9.7.11 Breakaway Audio Playout Device

Select an external audio device.

9.7.12 Breakaway Audio Material ID

Specify an item of material from the external audio device configured above.

9.7.13 Guard Playout Device

The device in use for the guard channel.

9.7.14 Guard Material ID

Specify an item of material from the guard device configured above.

9.7.15 Mix In Duration

The time taken to move from black to the first frame of the next event.

9.7.16 Mix Out Duration

The time taken to move from the last frame of an event to black.

Note: • It is common practice to follow a live event with a manual take event.

• If the schedule contains a live event whose duration is uncertain, the Manual Take 
check box for the following item should be checked so that it can be run using 
Take Next.
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9.7.17 Transition Offset

The offset from zero when configuring a transition type. Refer to Section 9.7.9 Transition Type 
for further information.

9.7.18 Playout Device

The main playout device for the event.

9.7.19 Guard Source

The mixer source for the guard device (e.g. a decoder on an ICE).

9.7.20 End Time Offset

The time difference between the end of the secondary event and the end of the primary event. 

The End Time Offset is used only when the Duration Mode is set to Relative to Owner. 
Refer to ‘Duration Mode’ below.

The end time offset can be negative or positive:

• A positive end time offset means that the secondary event ends after the end of the 
primary event.

• A negative end time offset means that the secondary event ends before the end of the 
primary event.

9.7.20.1 Changing the End Time Offset

• In the End Time Offset field, enter the offset in hh:mm:ss:ff (hours:minutes:sec-
onds:frames).

• To set a negative offset, enter a minus sign at the beginning of the End Time Offset 
field.

9.7.21 Aspect Ratio

This is the aspect ratio for the material on the playout device.

Note: The ability to enter a negative End Time Offset depends on the system configuration.
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9.7.22 Event Material Type

This field shows the type of material for the event. There are five types of material: 
programme, commercial, junction, live and live record. Each is described in the following 
table.

If the system configuration allows it, select the required type from the list.

9.7.23 Audio Lag Rate

‘Audio lag’ is the offset from the start of the selected event to the point at which the audio for 
the previous event starts to fade out. If the fade out is delayed, this is called ‘late lag’. If it is 
advanced, this is called ‘early lag’.

This option determines how fast the audio from an event fades out over the next event.

9.7.24 Audio Lag Out

This is the amount of time to keep the audio playing into the next event.

Material Type Description

Programme Main programme items

Commercial Revenue-generating advertisements

Junction Channel indents and other interstitials

Live A live studio item

Live record An item that was recorded live or crash recorded and may contain, for 
example, unexpected black

Table 10   Material Types
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9.7.25 Duration Mode

The ‘duration mode’ of an event determines how its duration is set. The Duration Mode field 
is displayed on the Property Inspector when an event has secondary events. The options are 
described below. Only one of them, UseChildren, applies to a primary event.

9.7.26 Device

The main playout device for the event.

9.7.27 Event Name

This links to the Title field on the schedule (refer to Chapter 3.2.3 Event Field: Title) and 
shows the title of the event. It is possible to change the title if the system configuration allows 
this.

Material Type Description

Specified Specifies the duration of the secondary event independently rather 
than taking the duration from the parent event.

UseOwner Sets the duration of the secondary event to be equal to that of its 
owner.

UseChildren Sets the duration of the parent event to equal the total duration of its 
child events.

It is generally used for Break Headers (refer to page 112).

EndWithOwner Causes the secondary event to end at the same time as the primary 
event.

The start time of the secondary event is determined by an offset from 
the end of the primary event (refer to ‘Offset’ on page 172).

The Reference to Parent’s End Start Mode is used (refer to 
‘Start Mode’ on page 173).

The duration of the secondary event is the same as the offset.

This should be a negative offset, making the secondary event start 
before the end of the primary.

This duration mode can also be used with a positive offset and the 
Start Mode set to Reference to parent’s beginning.

RelativeToOwner Allows two offsets to be set, one from the start and one from the end 
of the parent event.

This is the only mode that uses the End Time Offset setting (refer to 
page 191).

Table 11   Duration Mode Options

Note: The two most common settings are ‘Specified’ and ‘Use Children’.

Note: In order to reset the Event Name/Material ID properties to their original values, use the 
Query button (refer to page 170).
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9.7.28 Device Group

This is the group (refer to the Device Manager application) that contains the playout device.

9.7.29 Audio Mix In Duration

This is the time it takes for audio to fade up on an event.

9.7.30 Multipart Programme Id

The Multipart Programme Id field is used to link together segments of a programme. For 
example, a live item might be split by commercial breaks or a film by a news item.

Type the same identifier in the Multipart Programme Id field for each segment.

9.7.30.1 Configuration Options

The manner in which the Multipart Programme ID affects the event depends on the system 
configuration. One of the following options may be configured:

• Change next part

If a segment over runs or under runs, this parameter allows an adjustment to be made 
to the duration of the next segment.

• Change next part without shortening

If a segment under runs, this parameter allows the duration of the next segment to be 
increased. It prevents the operator from reducing the duration if the segment over 
runs.

• Change onward from next part with threshold

If a segment over runs, this parameter allows the duration of the next segment to be 
reduced until it reaches the threshold setting (refer to ‘Threshold Setting’ below), then 
reduce the duration of the following segment, and so on.

• Change last part

If a segment over runs or under runs, this parameter allows the required adjustment to 
be made to the duration of the last segment in the Multipart Programme ID group.

• Change backwards from last part with threshold 

If a segment over runs, this parameter allows the duration of the last segment to be 
reduced until it reaches the threshold setting, then reduce the duration of the penulti-
mate segment, and so on.

9.7.30.2 Threshold Setting (hh:mm:ss:ff)

This is the minimum duration of any segment (the default is 30 seconds).

Note: A multipart programme ID must be unique to a specific program within a channel. This 
means that appended schedules should not contain multipart programme IDs that exist in 
the previously loaded and active schedule.

For server based material, the Material Decorator (refer to page 168) does not overwrite 
changes made to fields such as Duration.
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9.7.31 Playout Device Group

This is the group (refer to the Device Manager application) that contains the playout device.

9.7.32 Material Id

This links to the Title field on the schedule (refer to Chapter 3.2.3 Event Field: Title) and 
shows the material ID of the event. The Material ID can be changed if the system 
configuration allows it.

9.7.33 Audio Lag

‘Audio lag’ is the offset from the start of the selected event to the point at which the audio for 
the previous event starts to fade out. If the fade out is delayed, this is called ‘late lag’. If it is 
advanced, this is called ‘early lag’.

9.7.34 Audio Gain

The volume of the audio output.

9.7.35 Audio Mix Out Duration

The time it takes for audio to fade down on an event.

9.7.36 Audio Lead

How far ahead the audio starts before the event.

9.7.37 Audio Mode

An option to allow the inputs and outputs to be configured on the selected mixer.
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9.8 Playout Device Properties

The fields that appear on the playout device section of the Property Inspector.

9.8.1 File Id

The File ID field shows the name used by Morpheus to locate a file on the video server.

9.8.2 Storage Device

The device that contains the material.

9.8.3 Start Mode

Use this field to specify whether a secondary event starts at the end or beginning of the parent 
event. Each option is described below.

9.8.3.1 Reference to Parent’s Beginning

Select this option to start the secondary event at the same time as its parent, taking into 
account any offset (refer to ‘Offset’ below).

9.8.3.2 Reference to Parent’s End

Select this option to start the secondary event at the end of the parent event, taking into 
account any offset (refer to ‘Offset’ below).

9.8.4 Is Guard Event

If a guard source (refer to page 33) is set up for an event, the material event relating to it is 
shown with this check box selected.

Important: A note on terminology.

The term ‘Parent’ and ‘Owner’ are entirely interchangeable, except when referring to the 
Start Mode of a Follow On event, and at any level deeper than the top level, as follows:

• An event Start Type of ‘Fixed’ establishes a new datum for the start time, therefore 
the Start Modes ReferenceToParentsBeginning and ReferenceToParentsEnd 
define ‘Parent’ as referring to the owner event.

• With an event start type of ‘Follow On’, the Start Modes ReferenceToParentsBegin-
ning and ReferenceToParentsEnd define ‘Parent’ as referring to the previous sib-
ling event.

•
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9.8.5 Start Time Offset

This option sets the offset between the parent event starting and the child event starting 
afterwards.

9.8.6 Inpoint

An event’s inpoint determines at which timepoint, in the tape item or server file, the device 
cues up and plays.

This is normally 00:00:00:00 (hours, minutes, seconds, frames) for a server event or 
10:00:00:00 for a tape event (depending on the station’s method of working).

9.8.6.1 The Timecode Entry Dialog Box

Click on the button to the right of the Inpoint field (Calc) in order to display the Timecode 
Entry dialog box. This allows the inpoint, outpoint (when the device stops playing) and 
duration of the event to be changed whilst maintaining a constant relationship between the 
three values.

• To change the inpoint, outpoint and/or duration enter the new timecode in the fields 
provided. and click Apply.

• To reset the inpoint to the database timecode, click on the Reset button next to the 
InPoint field. This also resets the outpoint.

• To reset the duration to the database timecode, click on the DB? button next to the 
Duration field.

Figure 93    Timecode Entry Dialog Box
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• To return the timecode fields to their previous values, click on the Reset button at the 
bottom of the database.

• The fields on the Inpoint Attributes tab are for information only and cannot be 
changed.

9.8.7 Duration

Associated with the Duration field on the schedule (refer to Chapter 3.2.6 Event Field: 
Duration) and shows how long an event lasts in hours, minutes, seconds and frames.

Use this field to change the duration, if the system configuration allows it. Use caution when 
increasing the duration - it is likely to result in playing out black. Decreasing the duration 
truncates the item.

9.8.8 Material Id

Associated with the Title field on the schedule (refer to Chapter 3.2.3 Event Field: Title) and 
shows the material ID of the event. The Material ID can be changed if the system 
configuration allows it.

9.8.9 Event Name

Associated with the Title field on the schedule (refer to Chapter 3.2.3 Event Field: Title) and 
shows the title of the event. The title can be changed if the system configuration allows this.

9.8.10 Event Material Type

Displays the type of material for the event. Refer to Section 9.7.22 Event Material Type for 
further information.

9.8.11 End Time Offset

The time difference between the end of the secondary event and the end of the primary event. 
Refer to Section 9.7.20 End Time Offset for further information.

9.8.12 Device Group

The group (refer to the Device Manager application) that contains the playout device.

9.8.13 Device

The main playout device for the event.

Note: If the inpoint/outpoint do not match those in the database, icons may appear in the event’s 
Validation field (refer to page 38).

Note: In order to reset the Event Name/Material ID properties to their original values, do so 
using the Query button (refer to page 170).
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9.9 Miscellaneous properties

Depending upon the system configuration, the following properties may or may not appear on 
the Property Inspector.

9.9.1 True Time

‘True time’ is absolute time. Morpheus only takes a fixed event (refer to page 122) to air if it is 
in the preset position. If it is further down the list, the system issues a a warning and two 
different start times:

• One to indicate the fixed time.

• The other to indicate the earliest time that Morpheus can execute the event. This is 
based on the events between the preset event and the fixed event.

When a fixed event has the True Time check box on the Property Inspector selected, 
Morpheus begins to disable the events between the preset and the fixed event. The fixed 
event becomes the preset event and rolls at the fixed time.

Note: The number of events that are skipped depends on the system setting.
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9.9.2 Time Link Declaration/Time Link Reference

The Time Link Declaration and Time Link Reference fields link the start time of events in 
two different channels (refer to ‘Start Time’ on page 26). If the start time of the declared event 
changes, the start time of the referenced event also changes.

The declared event acts as the master. Add a unique alphanumeric code to the Time Link 
Declaration field for the master event. The referenced event acts as the slave. Add the same 
code to the Time Link Reference field for the slave event.

The system sets the start time of the reference events to be the same as the declaring event.

The start time of the referenced event always follows that of the declared event, even if this 
means creating an over run or under run in the schedule. However, the reference events are 
still subject to the priority rules where an event is not allowed to wholly truncate the previous 
event - otherwise it adopts a follow-on start time to protect the previous event. In order to 
reduce the risk of this occurrence, all reference events are treated as True Time events. This 
is a mechanism that disables events that are preventing a True Time event from starting at 
the specified time. However because the True Time mechanism has a performance cost, it is 
normally limited to working on a configurable (no more than 10) number of top-level events in 
a channel.

The automatic change of the referenced event’s start time may cause a multiple event 
overlap. In this case, dual start times are not shown in the Start Time field for the referenced 
event. When the referenced event becomes the preset event, it is not put into manual take 
mode (refer to page 190). Instead, intervening events are disabled (their durations are made 
zero and they are 'hatched' out in the Editor window) to eliminate the multiple event overlap. 
The referenced event still runs at the same time as the declared event.

The linking is at event level and does not imply any global linking between all events in the 
two channels.

Time linking is only:

• Supported for top-level events

• Applied to start times, not durations

• Supported for channels within the same EventStore

9.9.2.1 Deleting Timelinked Events

1. Select the master event and do one of the following:

• Right-click on the event and choose Delete Linked Events.

• Press Shift+Delete.

2. To confirm, click Yes. Both events are deleted.

Note: The referenced event must be in fixed start mode (refer to page 122). Change the start 
mode of an event using the Start Type field on the Property Inspector (refer to page 174).

Note: Copying and pasting events clears out an Time Link declarations if it is pasted within the 
same EventStore. However, cutting and pasting preserves Time Link declarations.
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9.9.2.2 Timelinking Hierarchy Templates

When there are many timelink declarations and references in a large schedule, it is 
sometimes possible to inadvertently create an invalid relationship between the ‘master’ and 
‘slave’ events. Using a timelink hierarchy template prevents this situation. For further 
information, refer to Section 4.16 Timelink Hierarchy.
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9.9.3 Selected Break

Depending on the system configuration, it may be possible to schedule consecutive 
commercial breaks - one of the breaks will be disabled automatically. Using the right-click 
menu, the other break can be disabled, and then it becomes possible to toggle between that 
which is enabled and that which is disabled.

When alternate breaks are enabled, the Selected Break check box is displayed on the 
Property Inspector.

9.9.4 Transition Duration

This field shows how long the transition lasts in hours, minutes, seconds and frames.

Use this field to change the transition duration.

9.9.5 Notes

This displays any notes that have been added to the event. If a note has been added, the 
following is displayed in the Notes field on the schedule.

• Double-click on the notes icon to display the note.

9.9.6 QC/Reviewed

These fields relate to the quality control of an event. Icons indicating the quality control for an 
event appear in the QC field on the schedule (refer to page 37).
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9.10 Updating the Database

If required, it is possible to make changes to specific event fields and update the Morpheus 
media management database (refer to page 212) with them.

1. On the schedule, right-click on the required event and choose Update Database.

The Update Database dialog box is displayed.

2. Edit the fields as required.

3. Click Update to apply the changes to the database.

Note: The changes only apply to the event on the selected device. For example, if the inpoint 
(refer to page 190) of a clip on the main server is changed, the inpoint of the same clip on 
the ingest server does not change.

Note: When changes are made to a field, its background is highlighted in red.

Figure 94   Update Database Dialog Box
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9.11 The Schedule Object Inspector

The Schedule Object Inspector contains information on a Schedule Object that is present in 
the Editor. Morpheus uses Schedule Objects to group together events in a flexible way - for 
example, on a daily, hourly, or even on a show-by-show basis as required. These Schedule 
Objects are contained within schedule files.

When a schedule file that is not part of a Schedule Object is loaded into the Editor, Morpheus 
assigns it a Schedule Information Object ID. On saving the schedule file, the Schedule 
Information Object ID information remains in the schedule file.

Clicking on an event displays information about the Schedule Object that contains the event 
on the Schedule Object Inspector.

The Scheduled Object Inspector is displayed next to the Property Inspector as shown in the 
example below:

The information on this tab includes:

• The schedule name

• The external ID (this is a unique identifier for the schedule)

• A set of schedule properties

This information is defined in the schedule file as shown in the example below:

<ScheduleInformationList>
<ScheduleInformation Name="Friday Schedule" 
ExternalId="00000000-0000-0000-0000-0e1758987404">
<Parameter Name="BasisNo" Value="9535" />
<Parameter Name="BroadcastDate" Value="2011-12-20T00:00:00" />
<Parameter Name="FeedNo" Value="1" />
<Parameter Name="OnAirDate" Value="12-Jan-2013" />
<Parameter Name="RecordShowMatId" Value="X916_12_JAN_2013" />
<Parameter Name="AsRunKey" Value="12345/abc" />
</ScheduleInformation>
</ScheduleInformationList>

Figure 95   Schedule Inspector Tab
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Properties can include information such as the last time the schedule went to air. 

Depending on the Editor configuration, it is possible to edit the parameter values in the 
Schedule Object Inspector.

9.11.1 Editing Schedule Object information

Editable parameters appear in bold, italic text.

To edit a parameter value:

1. Double click on the parameter or right-click on the parameter and select Edit as 
shown below:

2. Replace the parameter value as required.

3. Press Enter.

Figure 96   Editing SIO information
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10. Missing Material Report

The ‘missing material report’ checks for and lists the following:

• Missing material

• Material on other devices

• Material requiring ingest

• Events with titles that do not match the titles in the Morpheus media management 
database (refer to page 212)

• Events with durations that do not match the durations in the database

The missing material report only works on the schedule that is currently loaded.

To display the missing material report:

• From the Editor Tools menu, select Missing Material Report. The report is displayed 
as shown below:

Figure 97    Missing Material Report

Note: The columns that appear and the settings available depend on the Editor configuration.
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10.1 Selecting Channels

When the Missing Material Report starts, there is no data to view. In order to view the missing 
material, it is necessary to select those channels to be included in the report as follows:

1. Click on the Channels button:

2. Select a channel(s) from the list as shown below:

3. Click OK to save the settings. 

Figure 98    Missing Material Report - Channel Selection Window
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10.2 Running the Missing Material Report

To run the report and view the missing material:

• Click Query -> Execute on the toolbar menu, or click on the Run Report button:

The missing material list is displayed in the main window.

10.3 Selecting Items

Before performing an action on an item, such as fixing a title or duration, it must be selected 
as follows:

• Select the check boxes for all relevant items (clear those that are not to be included).

• To select all items, right-click and select Select All.

• To clear all items, right-click and select Select None.

• To reverse the selection, right-click and select Invert selection. All of the items that 
were selected become deselected and all of the items that were deselected become 
selected.

10.4 Repairing Titles

If the title of an event does not match the title in the database, it is possible to reset the title of 
events on the schedule as follows:

1. Select the check box(es) for the relevant event(s).

2. Click on the Repair Titles button as shown below:

Once the material is repaired, it disappears from the Missing Material Report.

10.5 Fix Durations

If the duration of an event does not match the duration in the database, the duration of events 
on the schedule can be reset as follows:

1. Select the check box(es) for the relevant event(s).

2. Click on the Repair Durations button as shown below:

Once the material is repaired, it disappears from the Missing Material Report.

Note: The Missing Material Report can also run in Auto Update mode where the report is 
automatically and periodically updated without the user clicking the Run Report button (it 
can be enabled on the Missing Material Tab in the Editor Configuration window.
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10.6 Post Transfers

The Post Transfers option enters requests into the ‘Transfer Request’ table. This is a table in 
the Morpheus media management database (refer to page 212) that keeps a record of all 
requests for material to be ingested or moved.

1. Select the check boxes for the relevant item(s).

2. Click on the Post Transfers button as shown below:

10.7 Additional Settings

The additional options that appear on the Missing Material Report window are described in 
this section.

10.7.1 Timezone UTC+

This option allows the timezone to be altered by a specified number of hours. For example, to 
move the timezone ahead 3 hours, enter 3 in the Timezone UTC+ field. To move the 
timezone back 4 hours, type -4 in the Timezone UTC+field (alternatively, use the up and 
down arrows to the right of the field).

10.8 If PID 

Unspecified Use Default PID 1

This option configures the PID that is used in a Transfer Request.

Note: When a transfer request has been posted, a yellow barrel is displayed in the Main column 
for the event. It is also displayed in the Grd column if this is configured to be displayed. 
refer to ‘Status Barrels’ on page 34. If the transfer request fails, a cross is displayed on the 
yellow barrel. If this occurs, the request can be re-issued as follows: right-click on the event 
and choose Re-Post Transfer Request.

Note: To apply the change, it is necessary to close the Material Report window and then reopen 
it.
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10.9 Filters

If the ‘Enable filters’ option is selected in the Editor configuration, the Filters panel is 
displayed on the main window as shown below:

The Filters panel contains the following options:

- Show duplicates

Display duplicates of material.

- Show Programmes

Include Programmes in the results.

- Show Live Events

Include Live Events in the results.

- Show Commercials

Include Commercials in the results.

Figure 99    Missing Material Report Filters
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- Show Junctions

Include Junctions in the results.

- Video Servers

Select one or more video servers from the list to include in the results.

10.10 Printing / Previewing the Report

To print the report, click File on the tool bar menu and then select one of the following options:

• Select the required printer using Print Setup.

• Click Print Preview to preview the report before printing it.

• Click Print to print the report.

10.11 Exporting to CSV

Allows the report to be saved as a .CSV file that can be opened in Microsoft Excel, or another 
application of choice.

To save a report:

1. Click Data and then Export to CSV on the toolbar menu.

2. Select a file location from the dialog box and click Save. The file has the name format: 
Missing Material <dd-Month-yyyy hhmm>.csv.
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11. The Timeplane

The ‘Timeplane’ is a multi-channel schedule display in time-proportional, graphical format. It 
is possible to zoom in and out to display all channels simultaneously - useful in a multi-region 
situation with opt-out channels.

Figure 100   The Timeplane

Note: The Timeplane in Figure 100 has a vertical display. However, it may be configured to show 
a horizontal display. The options available in the Timeplane depend on the system 
configuration.
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11.1 Starting the Timeplane

11.1.1 Starting the Timeplane using the Desktop Shortcut

Double-click on the shortcut to open the Timeplane.

11.1.2 Starting the Timeplane Using the Morpheus Shortcuts Folder

1. On the desktop, open the Morpheus Shortcuts folder and double-click Timeplane.

The Role Login dialog box is displayed. 

2. Select a Role Name, if applicable. The system may be configured to select the role 
automatically.

3. Enter a Password, if applicable and then click OK.

11.2 Zooming In and Out of the Timeplane Window

• To zoom in, click on the Zoom In button on the toolbar.

• To zoom out, click on the Zoom Out button on the toolbar.

11.3 Moving Around the Timeplane

• To move to the last event on the Timeplane, click on the Go To Bottom button on the 
toolbar.

• To move to the top of the Timeplane, click on the Go To Top button on the toolbar.
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12. Head Up Displays

Morpheus has the following methods of displaying read-only channel information:

• HydraHUD - a web-based application that can display the contents of up to 10 chan-
nels at once.

• The HUD - an application that displays a limited, read-only view of one channel (refer 
to page 204)
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12.1 HydraHUD

A web-based application that can run in a Web browser on any machine that has access over 
a network to the Morpheus server. We recommend Google Chrome as it is the defacto 
standard browser for all professional Web applications due to its rich feature set.

HydraHUD provides a limited, read-only view of up to 10 channels with limited event 
look-ahead (refer to page 210). 

The following items of event data are available for each channel:

• Duration

• Start time

• Device

• Main source status (material and device barrels)

• Hold

• Manual Take

• Material ID

• Notes

• Source

• Title

• Transition

For information on installing and configuring HydraHUD, Refer to the Morpheus Engineer’s 
Manual.

Figure 101    HydraHUD
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12.2 The HUD

The ‘HUD’ gives a limited, read-only view of one channel with limited event look-ahead (refer 
to page 210). It can appear on a separate workstation to the main Morpheus system.

The HUD is a separate instance of the Editor - it is typically used in a public area to provide a 
view of the next few events in the chosen channel.

It is often used to display imminent events in concise form, using a large font and customised 
color configuration.

Figure 102    The HUD

Note: Second line information within the event rows may have been suppressed in the 
configuration.
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Error messages are shown in a moving banner at the bottom of the HUD as shown in the 
example below:

Underruns, overruns and start time conflicts are shown on the bottom right-side of the display 
as shown in the example below:

Figure 103    Error Message Banner

Figure 104    Underrun error
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12.2.1 Starting the HUD

12.2.1.1 Starting the HUD Using the Desktop Shortcut

• There may have be a shortcut for the HUD on the desktop. If so, double-click on the 
shortcut to open the HUD.

12.2.1.2 Starting the HUD using the Morpheus Shortcuts Folder

1. On the desktop, open the Morpheus Shortcuts folder.

2. Double-click HUD. The Role Login dialog box is displayed. 

3. Select a Role name, if applicable - the system may be configured so that the role is 
selected automatically.

4. Enter a Password, if applicable and then click OK.

12.2.2 Right-Click Menu

The following menu is displayed when right-clicking the schedule area of the HUD window:

- Configuration

Access to the configuration menu is password protected. Refer to the Engineer’s Manual.

- Alarms

Display the alarms window.

- Full Screen / Normal Screen

Use Full Screen Mode to display the HUD. To exit full screen mode click on Normal 
Screen (only displayed when in Full Screen Mode).

- Close

Shut down the HUD application.

- About

Display the Morpheus software version and Grass Valley contact information.
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12.2.3 The HUD Toolbar

The ‘toolbar’ is displayed at the bottom of the HUD window. Each toolbar button is described 
in the table below.

Button Description

Hold. This puts the on-air event on hold. A hold icon is displayed in 
the on-air event’s Start Time field.

The event remains on hold either until either Hold is clicked again or 
Take Next is clicked (refer to ‘Take Next’ below).

Auto On. This is the default mode for Morpheus and indicates that all 
devices are receiving communication.

To disable automation, click Auto On. To switch automation back on, 
click Auto On again.

Take Next. This takes the on-air event off air and places the preset 
event on air (the preset event is the event that follows the on-air 
event).

Skip Next. This deletes the preset event and replaces it with the event 
after it. It is important to ensure that there is enough time for the new 
preset event to cue up.

Take Guard. This Activates the guard for the on-air event (refer to 
‘Guard Source’ on page 33).

All events using the same device as the on-air event are switched to 
the guard.

Explode Sub Events. This shows any secondary events on the 
schedule (refer to ‘Primary and Secondary Events on page 108).

Explode Breaks. This highlights all the breaks on the schedule.

Scroll Up. This moves up the schedule to the previous event.

Scroll Down. This moves down the schedule to the next event.

Delete. This deletes the highlighted event.

Undelete. This restores the event that was last deleted.

Preview. This previews the event on its scheduled device.

Table 12   The HUD Toolbar
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13. Appendix - Overview of Morpheus Applications and Processes

This section provides brief information on some of the Morpheus applications and processes 
that run in the background.

13.1 Device Controller Card

A ‘device controller card’ is a component of Morpheus that connects directly to controlled 
broadcast equipment.

It fits in a Grass Valley standard Icon frame and cables from broadcast devices terminate on a 
rear panel type 1433.
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13.2 Bridge

The ‘Bridge’ is an application that connects the device controller cards to the EventStore.

The main functions of the Bridge are as follows:

• To synchronize the device controller(s) with the EventStore, keeping them constantly 
'topped up' with event data looking a specified time into the future.

• To discard any event parameters that are not required by the device, for example, the 
event title would not be needed by a video server.

• To direct event data to the device controller that connects to the device specified in 
the event and not to the others.

• To receive timecode from the device controllers and pass it to the EventStore.

• To prioritize event data sent to the device controllers.

• To receive device status information from device controllers and update the 
Event Store accordingly.

The Bridge passes events from the EventStore to the kernel (refer to page 210) of whatever 
controller card has the right device connected to it, looking ahead in time according to the 
event look ahead setting (refer to page 210).

13.2.1 Device Status

The device status comes from the device via the controller card (refer to page 208) and the 
Bridge. It indicates whether a device is connected.

Figure 105    The Bridge
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13.2.2 Event Look Ahead

The ‘event look ahead’ is the period of time and minimum number of events that the Bridge 
uses to look ahead when preloading event data into the device controller cards (refer to 
page 208).

The look-ahead period is a vital way to ensure output continuity during testing, upgrades or 
network failures.

The time and number of events are set in the Bridge configuration (a typical setting might be 1 
hour and 200 events). The settings depend on a number of factors including the complexity of 
the schedules, the number of ports used per card, the presence or otherwise of guard devices 
(refer to page 33) and the need to allow enough time for a successful system restart.

Certain conditions, for example rippling (refer to page 52) involve significant processor power, 
and the main reason for limiting the event look-ahead is to avoid overloading the device 
controller cards.

On the schedule, events that fall outside the look ahead period have grey barrels in their Main 
status column, indicating that there is no response from the Bridge. This is because the 
Bridge cannot provide status information until event data bas been loaded into the kernel. 
This does not happen until the event comes within the event look ahead.

13.2.3 Kernel

The ‘kernel’ is the real-time operating system (OnTime), its configuration, and the Grass 
Valley software combined with it that runs on the controller card(s) (refer to page 208).
Issue 1 Rev. 2 Page 210



Morpheus V4.6 Appendix - Overview of Morpheus Applications and Processes
13.3 Configurator

The ‘Configurator’ is the configuration tool for the EventStore.

The primary functions of the Configurator:

• Configure and add ‘EventTypes’ (templates for new events on the schedule)

• Add and delete ‘categories’ (tabs on the Palette, refer to page 131)

• Move MediaBalls (refer to page 117) from one Palette tab to another

• Delete, edit and clone MediaBalls

• Configure the parameters that appear on the Property Inspector (refer to page 166)

• Configure secondary events (refer to page 108)

• Add, delete and configure ‘devices’ (pieces of equipment that are controlled by Mor-
pheus)

• Add, delete and configure channels

• Configure alarms

• Save configuration information for the EventStore to a file and import this file, if neces-
sary

• Configure multipart programme (refer to page 190), junction preview (refer to 
page 99) and rippling hold options (refer to page 52)

• Clear channels

Figure 106    The Configurator
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13.4 EventStore

The ‘EventStore’ is where the configuration for all the system’s channels is held, together with 
all the events that are scheduled to play out on those channels. It also performs all timing 
calculations including automatically determining the timing of the PGM and PST events based 
on the current time.

The contents of the EventStore are modified in the following conditions:

• A change is made to a channel schedule.

• An event goes into the past.

• A device, channel, EventType or source is added.

• A change is made to the configuration of any of the above.

• A change is made to the configuration of a Morpheus application.

• The Snapshotter (refer to page 216) takes its regular snapshot.

• A MediaBall (refer to page 117) is created.

13.5 Morpheus Media Management Database

The Morpheus media management database contains metadata (data about data) for every 
recording available to the automation system, for example, its title, duration, content, inpoint, 
format, aspect ratio and filename.

The Morpheus media management system updates the database whenever a media file is 
moved, copied or deleted by the media management system.

It is an accurate and up-do-date record of what media items are present and available (or 
potentially available) for playout.
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13.6 Morpheus Co-operative mode

This mode enables one Morpheus Editor to control channels across multiple Morpheus 
systems with different EventStore multicast addresses. 

The Editor shortcuts must have the following extensions:

• /a <multicast address1> /i “Name of Channel Group1”

• /a <multicast address2> /i “Name of Channel Group2” 

• etc...

To use co-operative mode:

1. Launch all of the shortcuts. 

2. Set the role permissions for each Editor as required.

One Editor application is displayed that contains the Channel Group names (config-
ured above) in the channel bar on the left. 

3. Click on a Channel Group name in order to see the channels for that group.

This feature is not available with the Timeplane application.

13.7 Morpheus System Health Monitor

On the Windows taskbar, there may be either a blinking red ‘M’ icon, or a green static M, to 
indicate the presence, or otherwise, of system alarms. This functionality is intended solely for 
support engineers.

13.8 Preroll

A video server is sent a ‘play’ command in advance of the event’s start time to allow for 
latency. This is called the pre-roll time.

A VTR is not capable of instantaneous stable playout and typically requires a few seconds’ 
preroll to guarantee a stable output at the desired inpoint (refer to page 190).
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13.9 Shell Services Host

‘Host Shell Services’ is an application within Morpheus that contains various services that can 
be used by the system. Some of these are described below.

13.9.1 AsRun DB Service

The ‘AsRun DB’ service keeps a record of the events that have played out on the schedule 
and writes this to the ‘AsRun’ database. The AsRun DB service can work with another 
application called the ‘Automation Database Reporter’ to produce ‘as run logs’ (refer to 
page 93).

13.9.2 Device Manager Service

This manages the allocation of devices to events in order to make optimum use of resources 
and eliminate conflicts in a multi channel environment.

Figure 107    HostShell Services
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13.9.3 Material Decorator Service

The Material Decorator populates empty fields in the Editor schedule and EventStore using 
data from the Morpheus media management database (refer to page 212). The fields that are 
decorated depend on the Material Decorator configuration.

The service uses the material ID and device ID to query the database and retrieve the 
relevant information.

The Material Decorator also enters a ‘status barrel’ (refer to page 34) in the Main column on 
the schedule. This barrel shows the event’s ‘material status’ (for example, whether or not the 
material is in the database or if a transfer is in progress, refer to ‘Transfer Decorator Service’ 
on page 215). It also enters a value for each event’s material status into the EventStore.

13.9.4 Transfer Decorator Service

The Transfer Decorator Service posts transfer requests for missing material (refer to ‘Missing 
Material Report’ on page 194) and reports the status of the transfer. It looks for events in the 
EventStore that:

• Have not yet started.

• Have a valid material ID specified.

• Have a storage device supplied by the material decorator (refer to page 215).

• Have a playout device specified.

• Have a video server requested as the playout device.

• Have a playout device that is enabled in the Transfer Decorator configuration.

• Have a material status indicating that the required material ID is not available on the 
chosen device. On the schedule, a red barrel is displayed on the left-hand side of the 
Main column - refer to Chapter 3.2.9 Event Fields: Main & Guard (Grd).
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13.10 Snapshotter

‘Snapshotter’ is an application within the EventStore that takes a 'snapshot' of the current 
model (refer to page 14) and deletes past updates from the ‘command queue’ (see below).

13.10.1 Model

The ‘model’ is a term used in Morpheus to denote 'the whole system as it now stands'. It 
consists of the last snapshot and any subsequent instructions in the command queue (refer to 
‘Queues’ below).

13.10.2 Queues

There are two queues within Morpheus - the ‘command queue’ and the ‘snapshot queue’. 
These queues are constantly written to a hard drive. This enables full recovery in the event of 
a server failure. Each is described below.

13.10.2.1 Command Queue

The command queue is one of two queues in the EventStore. It is a store of all transactions 
(for example, updates or changes) that have been passed to the EventStore since the last 
snapshot.

13.10.2.2 Snapshot Queue

The snapshot queue contains the last few snapshots from the Snapshotter.

Figure 108    Snapshotter
Issue 1 Rev. 2 Page 216



Morpheus V4.6 New Features in this Release

Issue 1 Rev. 2 Page 217

14. New Features in this Release

14.1 MOR-5305, ‘Duration Aired’ Column in the Editor

Chapter 3.2.15 Event Field: Duration Aired

14.2 MOR-5618, Back-to-Back Transitions on the Same Source

Chapter 3.2.5 Event Field: Mix

Chapter 9.7.9 Transition Type

14.3 MOR-5799, Dummy Source

Chapter 5.2.5.1 ‘Dummy’ Guard Source

14.4 MOR-5826, Updated Duration Modes in MediaBall Editor

Chapter 7.7.1 Creating a MediaBall



Contact Us
Grass Valley Technical Support
For details of our Regional Customer Support Offices please visit the Grass Valley website and 
navigate to Support> Contact Support.

https://www.grassvalley.com/support

UK Office
The department is staffed from 9.00am to 5:30pm Monday to Friday (excluding UK public holidays.

Outside these times, calls will be delivered to voicemail for follow up on the next working day.

Additional support is available outside these hours by purchasing a support contract, details of 
which are available from the Grass Valley website and through the account manager.

Customers with an existing support contract should call their personalised number, which can be 
found in the contract, and be ready to provide the contract number and details.

https://www.s-a-m.com/support/247-support 
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